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Introduction Client billing is based on jobs, tasks, and the costs you’ve posted against them.   Job 
tickets track everything you spend by task, whether it’s time, buyouts, or out-of-
pocket expenses. Invoices are created automatically from jobs and tasks using 
these unbilled amounts, making billing very fast, accurate, and easy. This chapter 
explains in detail how to add different kinds of invoices depending on what—and 
whom—you’re billing. You’ll see how the billing process works from start to finish. In 
this chapter you’ll learn about:

■  managing client accounts 
■  using the Sales>Maker to manage client contacts and sales campaigns
■  using the Meeting>Manager to coordinate staff and client meetings
■  client retainers
■  job invoices for different kinds of clients
■  billing estimates
■  billing media insertion orders very easily
■  tracking advance billings and retainers
■  printing A/R invoices
■  using the Billing Worksheet to manage how costs are billed
■  printing A/R reports
■  tracking client payments

For help using any part of Clients & Profits X, click the    button from any 

window to open the on-line user guide. This web-based user guide features 

step-by-step instructions, explanations, tips, demonstrations, and links to 

FAQs, tech notes, and tutorials from www.cnp-x.com/support.  The web site is 

continually updated, so it’s more timely and helpful than a printed user guide.
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Clients

Clients

Clients are the most essential part of your Clients & Profits X database for a 
simple reason:  A job ticket can’t be opened without one. Every job ticket is 
opened for one client. The client account maintains important details about 
your customers; name, contacts, address, telephone numbers, and balances.  
Clients & Profits X can manage jobs, estimates, costs, and billings for hun-
dreds of clients. In fact, there’s no real limit to the number of clients in your 
database (the limitations are based mostly on your hardware and network; 
more clients require faster systems).  

Every client has a unique account 
number or code.  This code identi-
fies the client throughout the system.  
Everything you do (time sheets, POs, 
payables, journal entries) gets a client 
code, which is copied automatically 
from the job ticket.  This makes it easy 
to print job lists, cost summaries, and 
profitability reports by client.

For better job tracking, you can have 
many clients from the same organi-
zation.  A large corporate client, for 
example, might have 100 different 
departments or contacts who initiate 
jobs. Anyone who authorizes work can 
be added as a separate client account. 
When jobs are billed, the work from 
several different clients can be combined on one invoice—and even billed to 
an entirely different client account.

Costs, billings, and the unbilled amount are tracked on the client’s job(s).  
Work in Progress reports are printed to subtotal by client, or printed for just 
one client or job.  The unbilled amount on the client’s job is updated when-
ever costs or billings are posted. So you can analyze the client’s costs and 
billings anytime during the month.

Clients can be billed automatically, based on the costs on the job.  When the 
cost is posted, both the cost and the billable amounts update the job ticket.  
So when it’s time to bill, the total unbilled amount—or any part of it—is 
quickly and accurately invoiced. Many different billing types and options are 
available to customize invoices for different clients.  
  
Outstanding balances are tracked by client, so you’ll always know just who 
owes you money—and for how long—by printing client account aging reports 
from Snapshots.  You can choose to age each invoice and subtotal by client, 
or just show totals for each client.  

Choosing client numbers

Client numbers are very important, since they appear throughout Clients & 
Profits X—and are used by everyone.  There’s a real art to picking the right 

client codes. You must choose a number that’s easy for everyone to remem-
ber, but meaningful enough to distinguish one client from another.

The client number itself can contain up to ten characters, including letters, 
numbers, and symbols. If your job numbers are set to contain the client 
number, then your options are much more limited. Since the job number itself 
can’t exceed ten digits, your client codes must be small if the job number is 
to contain the year, client, a dash, and the sequential number.

Example: A client code RETAIL won’t 
work if your jobs are numbered with 
the year and a dash.  If the next job is 
1024, the new job number for RETAIL 
would be 02-RETAIL-1024.  Since the 
job number itself can’t exceed 10 let-
ters, it would appear as 98-RETAIL-1, 
missing three important digits. So it’s 
best to use short, simple client num-
bers (like ABC, RET, FRG, etc.).

■  If you are worried about users not 
being able to recognize abbreviated 
client codes, remember that the client 
lookup list is available throughout the 
program. The client lookup list shows 
both the client code and complete 
client name.

Divisions and departments

Clients & Profits manages different departments and divisions.  Both are 
added as clients into your database.  First, the division should be added as 
a client. Then every department that authorizes jobs should be added as a 
separate client account. Every client account has its own account number, 
which you choose.   

Departments are associated with the division by the division’s client number.  
Each department client has a field for division—this is the division’s account 
number. Client account agings, client statements, profitability, and productiv-
ity reports can be run by division.

New job tickets should be opened for the department client number, not the 
division. This lets you track jobs by department, which is more informative. 
When a job is billed, you can change the client number on the invoice to 
another department—or the division itself.  By changing the invoice’s client 
number, you’re billing the work to a different client.  Regardless of who is 
billed for the work, the job is updated in the same way. For flexibility, the 
invoice’s billing address can be changed. Changing the invoice’s billing 
information only affects the invoice itself.
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A division can have many clients.  The division is entered as a client, then the division’s cli-
ent code is entered to each client account in the division field.

Default billing information, entered in the client account, is copied to the client’s invoice, 
(i.e. sales tax rate, finance charge, payment terms, a blanket PO number, and where copies 
are distributed to).  Billing rates are copied to job tickets which bill using the client rate.  
Account and retainer balances are tracked in the client account, as well as media job num-
ber, task, commission,  and current media estimate number. 

Contacts include the people responsible for the job, those who receive the statements and 
“other” contacts that may need to be referenced.  A billing address can be entered if differ-
ent from the client’s address.

The client’s quarterly billings and a graph comparing each quarter statistically are found in 
the client account.  Last year’s totals, if available, are also reported in Client Statistics. 

Monthly client budgets are entered and tracked against actual billings.  

Alerts are messages that are added for new jobs,  A/R invoices, and payments.  When a job 
or transaction is added for the client, the alert is displayed. 

The diary records the when, where, and who was involved for major events or meetings.  
Because the diary is easily accessed, details of conversations and events are preserved.  The 
record can also be e-mailed for streamlined communication.

E-mail is set up to be automatically sent to people working with the client when jobs, in-
voices, and payments are added for the client.

A list of the client’s projects opens when a job is opened for the client.  Enter a project code 
on a job to track the project’s progress on reports.

The Staff Access Privileges window restricts staff access to the client’s jobs.

Schedule the client’s retainer billings in the client file.  The invoice number is automatically 
entered to the schedule as the retainers are billed.  The balances of unused and unpaid 
retainers for the client are displayed.

Rates can be set up by task in the client account.  These special billing rates are only used 
if “always use billing rates from client” is chosen on the job’s task.

Many clients can belong to the same profit center.  If a profit center is assigned to a client, 
then only tasks with the client’s profit center can be added to the client’s job tickets.

Client Features

Client Fea-

Feature How it works, how it’s used

Divisions

Billing information

Contacts

Account statistics

Budgets

Alerts

Client diary

Automatic e-mail

Projects

Staff access privileges

Retainer schedules

Billing rates

Profit Centers
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The Clients Window

1  The arrow toolbar buttons 
can be used to scroll through 
the previous and next clients.

2  Clients can be easily added, 
edited, and deleted from the 
Clients window.  To add a new 
client, click on the add button.  
Once the client is added, it can 
be seen and used immediately 
by other users.  Click on the 
edit button to edit the client’s 
account information such as 
the status, address, key client 
contact, phone number, web 
site, account note, etc.  To 
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delete a client, click on the 
delete button.  If a client has a 
balance or a job ticket, it can’t 
be deleted.  Instead, make the 
client “inactive.” 

3  Click on the access privileges 
button to view or edit who has 
access to the client’s jobs.  A 
user with access can see the 
client’s jobs including the job 
tasks, costs, estimates, and 
billings.

4  To print a hard-copy printout 
of the client list, click on the 

print list button.  To print client 
labels, click on the print labels 
button.

5  Enter in a client code here 
to find a client.  Or use the find 
more link to find a client by 
account number, organization 
name, cost center, or sequence.

6 Use the show pop-up menu 
to see clients for one specific 
status or all statuses.

7  These links can be used to 
add, view, or edit the client’s 

a
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Clients are added, edited, and deleted in the Clients window.  The client information is 
easily changed, but the client code can’t be edited once the client has jobs or billings.  
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information.  Click on the bill-
ing info link to view or edit the 
client’s billing details, sales tax 
settings, retainer account, me-
dia defaults, copies to names, 
and billing address.  To add, 
view, or edit client projects, 
click on the projects link. The 
diary /calls link can be used to 
keep track of a client’s activity.  
The meetings link is similar 
to the client diary, except it 
is used to keep track of the 
details from all meetings with 
the client.  To set up a retainer 
schedule for the client, click on 
the retainers link.  

8  The view>point pop-up menu 
can be used to view the client’s 
job tickets, invoices, budget 
recap, account statistics, and 
job requests.

9  A client number is a 10-digit 
letter or number code that is 
customizable. It must be 
unique. It can only be changed 
on clients without jobs or 
billings; once a job is opened, 
the client number can only be 
renumbered.

10  This is the status of the 
client.    The client status can 
be selected in the Account 
Information window.  Status 
levels can be added or edited 
in Preferences > CRM (Client 
Relationship Manager).

11  In-house clients are used to 
track internal time. Time for in-
house clients won’t appear on 
client Profit & Loss statements.

12  The client’s organization 
name and address appear on 
printed estimates, invoices, and 
statements. A separate billing 
address can be entered on the 
Addresses window or Billing 
Info window.

13  The retainer graph shows 
the client’s retainer.  To view or 
edit the retainer schedule, click 
on the graph or use the retainer 
link.  

14  The monthly billings graph 
shows the client’s billings for 
the year broken down by each 
month.

15  The client’s contacts are 
listed here and can be easily 
added, edited, and viewed us-
ing these links.

16  The client’s open jobs 
appear here for easy reference.  
Double-click on a job number 
to jump to that job’s Job Ticket 
window.

17  Click on the notes link to 
add a note for the client.  Notes 
can be used to document any-
thing about a client.  They don’t 
appear on jobs or invoices, so 

they can include proprietary 
information about your relation-
ship with the client. 

18  A division is group of cli-
ents that belong to the same or-
ganization. One client account 
is set up as a division account; 
its client number becomes 
the division number. Both the 
division itself and its clients are 
separate client accounts.

19  This field shows the 
number of job tickets that have 
been opened for the client in 
the current accounting year.  

20  The sales>maker link lets 
you keep track of sales informa-
tion for the client, such as 
sales letters, sales e-mails, call 
scripts, and campaigns.  

21  The next follow-up field 
shows when the client will next 
be contacted.  

A client can be assigned to a division.  Divisions are used to group together clients 
who belong to the same organization.  Some job reports and accounts receivable re-
ports can be printed by division.  Billings can also be added for a division.
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The Add Client Account Win-
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1  The client number is a 
unique customizable, 10-digit 
letter or number code.  

2  Each client can belong to a 
division.

3 Use the status pop-up menu 
to choose a status for the client.  

4  The client’s organization 
name and address will appear 
on printed estimates and 
invoices.  

5  In-house clients  are used to 
track internal time.  Time for in-

house clients won’t appear on 
client Profit & Loss statements.

6  The key contact is the person 
most responsible for approving 
the client’s jobs.  It is copied to 
new jobs automatically. 

7  Every client can be assigned 
an account executive or team.  

8  For corporate clients, a Chg 
#/Cost Ctr code can be used for 
chargeback billing reports.    

9  An optional profit center 
groups this client with others 

in the same business unit.  If 
used, only tasks with the same 
profit center can be added to 
this client’s jobs.

10  Clients that will never be 
billed for their job costs should 
be marked as always unbillable.

11 If the client has more 
than one contact, they can be 
entered here with their e-mail 
address and phone number.

12  The account note contains 
any  important information 
about the client, such as billing 
instructions.

The Add Client Account Window

New clients can also be added while you are working elsewhere using the client’s 
Lookup List.
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The client’s staff access privileges controls who can see a client’s job tasks. If a user is given “no access” to a client, 
he or she can’t see the job’s tasks, estimates, costs, or billings. This option lets you define on a client-by-client basis 
just who can work with certain clients. Staff access privileges for clients only affect a user’s access to the job’s tasks. 
Access to other client-related areas in Clients & Profits (which includes most of the database) are not affected by 
these settings. When new staff members join the company, be sure to check their access to clients. Also, when a staff 
member leaves be sure to remove them from their client access privileges by clicking the “no access” checkbox. 

Client/Staff Access Privileges

The staff access privileges are designed for shops with competitive account teams.  
For security and accountability reasons, they would be prevented from seeing the jobs 
for other clients.
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1  To keep all users from ac-
cessing the client’s job tasks, 
click on the no access button.  
To give all users access to the 
client’s job tasks, click on the 
all access button. 

2  To print a hard-copy printout 
of the Staff Access List, click 
on the print list button. 

3  All staff members are 
listed by their staff code.  You 
can change the sort order by 
clicking on any of the column 
headings.

4  To deny a staff member ac-
cess to a client’s job tasks, click 
on the no access box.  
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The Client Contacts window is an excellent way to keep track of all the contacts for a client.  For each client 
contact you can enter in their full name, title, phone numbers for both work and home, fax numbers for both work 
and home, cell phone number, pager number, e-mail address, notes, an address, last time they called, the next 
expected phone call, and whether or not they are a decision-maker.  

For easy reference, the Clients window lists all client contacts with their work phone 
number and e-mail address.

Client Contacts

1  The client name appears 
here for reference.

2  Enter the client’s first name, 
middle initial, and last name. 
Type the salutation you wish to 
use, including the punctuation 
(e.g., Mr. Nigash: or Phil,).

3  Enter the client contact’s 
title.

4  Make a note here of the last 
time you contacted the client, 
then schedule your next call so 
you’ll be sure to follow up.

5  Enter the client’s work and 
home e-mail addresses.

6  You can add up to four dif-
ferent telephone numbers, and 
two fax numbers.  Additional 
numbers can be added to the 
notes window.

7  Enter the contact’s primary 
address here.

8  The options checkboxes let 
you indicate whether a client 
contact is a decision maker, 
and whether to send them sales 
e-mail.
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9  Add any notes here about the 
client to help jog your memory 
about likes and dislikes, favorite 
sports teams, who their supervi-
sor is, and more.
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You can add an unlimited number of client contacts to each client, so you’ll never 
lose track of someone.
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 1  Contacts can be easily add-
ed, edited, or deleted from the 
Client Contacts window.  To add 
a new client contact, click on 
the add button.  To edit a client 
contact’s information, click 
on the edit button.  To delete 
a contact, click on the delete 
button. To print the contact list, 
click the print button.

2  The client name appears 
here for reference.

3  The client contacts window 
lists contacts’ name, title, work 
e-mail, and work phone, since 
this is the most commonly used 
information. 
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Client Billing Information

Client Billing Information

1  To print a hard-copy printout 
of the Client Billing Info report, 
click on the print button.

2  The name of the current cli-
ent you are editing is displayed 
here.  

3  The client’s standard billing 
rate is copied to new job tasks, 
if the Preference setting is set 
to always copy billing rate from 
client. If entered, any time 
added for this client gets this 
rate, regardless of who did the 
work.

4  This markup overrides all 
other markups on job costs, 
regardless of the vendor. It is 
copied to job tasks, where it 
is used on A/P invoices and 
checks.  Don’t enter a markup 
here unless it is to be used 
everywhere.

5  This monthly finance charge 
is copied to new invoices.  
Finance charges are calculated 
on agings and statements, but 
don’t affect the General Ledger. 
If you actually charge—and get 
paid—the finance charge, it can 

be added as an adjustment on 
the client payment.

6  The payment terms are 
copied to new invoices. They 
appear on the printed invoice 
for the client to see.  It is a text 
field, so any kind of terms can 
be entered.

7  If a client issues a blanket 
PO for its jobs, enter it here. It 
will be copied to every new job.

8  A credit limit can be as-
signed to a client. When an 

The Billing Information window offers a wealth of details about the client.  This billing 
information affects the client’s jobs, costs, and A/R invoices.
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invoice is entered for the client 
that is over its credit limit, a 
warning message will appear.

9  Click the credit hold box to 
place a client on hold when 
they have reached their credit 
limit or have a history of not 
paying on time.  A client on 
hold won’t be able to have new 
jobs or billings added for them.

10  Every client can have two 
different sales tax rates. Sales 
taxes are calculated on taxable 
job tasks only, using the rates 
entered here. Sales tax rates 
can vary by client for flexibility.  
The sales tax county is used to 
subtotal invoices on the sales 
tax report.  

11  Up to five copies of an 
invoice can be printed auto-
matically, without using special 
forms. You can enter up to five 
distribution names here, which 
are copied to new invoices. 
These names appear at the bot-
tom of the printed invoices.

12  The unused balance is the 
balance of the retainers billed 
to clients (or retainer client 
payments), less amount applied 
to invoices. It is the amount you 
can apply as payments to up-
coming invoices. Retainer dGL, 
cGL is the client’s default debit 
and credit   G/L accounts.

Client Billing Information

A client’s billing information can be changed anytime.  Some of this information appears 
on the client list, but most doesn’t.  Any part of the billing information can be printed us-
ing custom reports.

13  The media job number, 
task and standard commis-
sion are copied to new media 
plans added for this client. The 
client’s media debit G/L number 
replaces the default A/R num-
ber on invoices when adding a 
media billing. The media est# 
field shows the media estimate 
number last used for this client.

14  A separate billing address 
can be added for the client 
here.  You can use the copy 
link to have the client’s address 
automatically entered for you.  
To clear the address, click on 
the clear link.
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Client Projects

It’s common for clients to track what they spend by project, program, or some other kind of category. When a new 
job is opened for a client, you can enter one of these codes into the project field. To keep your job tracking more 
consistent, you can establish a standard list of dozens of projects for each client. With projects, you’ll be able to 
easily show your clients how they spent their advertising dollars without creating spreadsheets.

Client Projects
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The word “project” is customizable as a system-wide preference. To rename “project,” 
choose Preferences from the Setup menu, then select the Names preferences. 

1  Client projects can be easily 
added, edited, and deleted. To 
add a new project, click on the 
add button. You can add dozens 
of projects for one client. To 
edit a project’s details, click 
on the edit button. Because 
projects are used for reporting 
purposes and don’t affect the 
G/L, they can be edited at any 
time.  To delete a project, click 
on the delete button.

2  To print the Client Project 
List, click on the print list 
button.

3  Client projects are listed by 
project name.  They can be 
resorted by clicking on any of 
the column headings.

4  The project name identi-
fies the project on job tickets, 
estimates, invoices, and other 
reports.  The name must be 
unique and should be a nick-
name for the project that other 
users will understand.

5  The description can be used 
to explain in detail what the 
project entails.

6  The status is used to de-
scribe what phase the project 
is currently in. The status is 
optional and can be shown in 
custom reports.

7  The budget can be used 
to show how much the client 
wants to spend on the project.  
The budget is optional and can 
be shown in custom reports.  
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Unlike the job diary, the client diary does not keep an automatic log of every client activity—it would generate an 
immense number of entries. Instead, the client diary is used like a daily log.  Each client diary entry includes the date 
and time it was added, as well as initials of the staff member who added it. The entry’s subject and description are 
user-defined. Client diary entries can be useful for tracking problems, such as overdue invoices. Since each entry has 
a “resolved” checkbox, the Client Diary window clearly shows at-a-glance which entries are still pending. Once the 
client’s issue is closed, anyone can mark the entry as “resolved.”

Client Diary/Call Log

Client Diary/Call Log

Client diary entries are part of the C&P e-mail system, and will automatically notify 
users at the right time and can be e-mailed to any staff member. 

1  To add a new diary entry, 
click on the add button.  Client 
diary entries can also be added 
from the Accounts Receivable 
and Client Payments window. 

2  Diary entries can be easily 
edited and deleted.  To edit a 
diary entry, click on the edit 
button.  They can be edited at 
any time.  To delete a diary en-
try, click on the delete button. 
Only diary entries that you’ve 
added can be deleted.
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3  To print the Client Diary 
report, click on the print report 
button.

4  Client diary entries are 
sorted in the window by oldest 
entries first.  The entries can 
be resorted by clicking on any 
column heading.

5  When is the date a diary 
entry was added.  The checkbox 
shows which entries have been 
resolved by marking them with 
an “X”.

6  Who is the person that added 
the client diary entry.

7  Event/action tells you what 
the subject of the client di-
ary entry is.    Double-click 
on a diary entry to see its full 
description.

8  An optional invoice number 
can be entered for each client 
diary entry.  This field is useful 
when adding an entry for chang-
es or notes about a particular 
client billing.



6-16

Meeting>Manager

Meeting>Manager

The meeting manager works like the client diary/call log. It allows account executives and others to keep track of 
meetings. Anyone working with this client’s jobs can add an entry to record the notes, the location, the time, the 
attendees, the coordinator, and the topic discussed at a client meeting. The meeting manager also allows a meeting 
coordinator to e-mail all the attendees of a meeting of new changes or for the times of future follow-up meetings.  
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1  Client meeting entries can be 
easily added, edited, deleted, 
and canceled.  To add a new 
client meeting entry, click on 
the add button.  Client meeting 
entries  can be scheduled in 
advance or added after they 
have taken place.   To edit the 
details of a meeting entry, click 
on the edit button.  To delete 
a meeting entry, click on the 
delete button.  Entries can be 
deleted at any time.  However, 
for better accountability, it is 
better to mark a meeting as 
“canceled” by clicking on the 

cancel button.  Cancelling 
a meeting retains all of the 
details of a planned meeting 
for future reference.  If an entry 
is deleted, then no details will 
appear in the Meetings Manager 
window.

2  To print the Client Meet-
ing List, click on the print list 
button.  To printout a worksheet 
of a client meeting entry with a 
summary of the discussion and 
action items, click on the print 
worksheet button.

3  Click on the meeting sum-
mary link to add the details of 
the meeting discussion, to list 
the action items, to schedule 
a follow-up meeting, and to 
e-mail the attendees.

4  Client meeting entries are 
sorted by most recent entry 
first.  You can resort the list by 
clicking on any column head-
ing.

5  Date is when the meeting 
took place or when the entry 
was added.  An “X” in the 

Instead of deleting planned meetings that never happened, cancel them instead.  
Canceling lets you keep all the details and makes it easier to reschedule if necessary.
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checkbox, identifies client 
meeting entries that have a 
completed meeting summary.

6  The location is the place a 
meeting took place.

7  Coordinator is the person 
who was in charge of the meet-
ing.  Typically, this person is 
a department manager or an 
account executive.

8  Topic is a brief description of 
what a meeting was about.  To 
see the full details of a meeting 
entry, double-click on it.

9  Job identifies what job ticket 
the meeting was called for.  It is 
optional.

10  The meeting address/direc-
tions gives you the directions of 
how to get to the location of a 
meeting.

11  Attendees shows who 
attended, or is scheduled to at-
tend, a particular meeting.  

 

Use the meeting summary to keep a record of the discussion and action items of a meet-
ing.  You can also automatically setup a follow-up meeting and notify via e-mail the at-
tendees of that client meeting.

Meeting>Manager
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1  Click on the delete button 
to completely remove informa-
tion about the meeting from the 
database.  If the meeting is ten-
tative, go ahead and schedule 
it, then mark it cancelled later, 
or edit the date and time.
Use the print button to print a 
meeting worksheet—a great tool 
for keeping notes at the meet-
ing and completing the meeting 
summary.

2  The status line will be blank 
until you click save. After sav-
ing, the meeting status defaults 
to upcoming. The initials of the 
person who added the meeting 
are automatically filled in.

3  Enter the date and time for 
the meeting.  Time is entered 
on a 24-hour clock (i.e., mili-
tary time), but appears with a 

12-hour AM/PM configuration.

4  Enter the initials of the per-
son coordinating the meeting. 
Clients & Profits automatically 
adds the person who is adding 
the meeting.

5  Enter a brief description of 
what the meeting is about in 
the topic field.

6  The location is where the 
meeting will be held, such as 
a conference room, hotel, or 
client’s office. Enter the loca-
tion address and any necessary 
information about getting there, 
such as parking, tricky exits, or 
other caveats.

7  If the meeting is about a 
particular job, enter its job 
number here.  Because this 

isn’t required, the Lookup Job 
Tickets list won’t automatically 
open, but you can access it by 
choosing Lookup > Job Tickets.

8 Enter the meeting objectives 
so everyone knows what the 
goals are.  

9  Click on the names of 
meeting attendees. To choose 
several names, hold down the 
command (Mac) or control 
(Windows) key.

10  Check the notify all attend-
ees box to send an e-mail to 
everyone who will be attending 
the meeting. To send an e-mail 
to someone who isn’t on the 
attendees list—but needs to 
know about the meeting—enter 
an e-mail address here.

p

Details about a client meeting can be automatically e-mailed to every attendee when-
ever the meeting’s status changes.
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Client Retainers

Client Retainers

Client retainers can be automated in Clients & Profits through retainer 
schedules. Retainers in Clients & Profits are not flat monthly fees for certain 
services. Instead, they are prepayments for services that will eventually be 
billed.  The retainer will then be applied to the future billings.   

The retainer schedule lets you plan up to twelve different retainer billings. 
The retainer description and amount is copied to a special billing type in 
Accounts Receivable, the retainer invoice. The retainer invoices can bill one 
or more of the scheduled billings—without rekeying. The retainer schedule 
window also tracks your retainer invoices. When a retainer invoice is created, 
the invoice date and number update the retainer schedule. It’s easy to see 
just what retainers have and haven’t been invoiced.

You can enter a default debit and credit G/L account for your retainers.  These 
accounts are copied automatically to retainer invoices. If you set up special 
retainer payable and receivable accounts, you can easily show retainers on 
your financial statements.  

Retainers are tracked separately from regular billings on the client account 
and aging reports. Payments can be applied to unposted invoices from the 
retainer balance. When the invoice is posted, the client’s retainer balance 
decreases. When the invoice is printed, its balance due includes the payment 
from the retainer. Clients & Profits also tracks the retainer balance—based on 
whether clients have paid their retainer invoices.

Scheduling retainers doesn’t 
actually create invoices; instead, it 
simply sets up standard information 
for the retainer invoice. You’ll still 
bill a retainer at the beginning of 
each month, quarter, or other in-
terval. The retainer invoice doesn’t 
have a job or tasks.  It isn’t taxable, 
since you’re not creating anything. 
The retainer invoice is posted and 
printed just like other invoices.

Retainers can be applied to any 
invoice, including billings for non-
job charges like account fees.  They 
are applied to unposted invoices, 
and act like client payments. The 
invoice is posted in full to the 
General Ledger, like other invoices. 
But the retainer you apply to the 
invoice debits and credits the G/L 
just like a client payment.  

Retainer invoices are different 
from advanced billings. Retainers 
are billings to clients, but not for 
a specific job. To bill a job for a 
deposit, an advance billing should 
be used instead. An advanced 
billing invoices a selected job for a 
prepayment. Advances don’t have 
tasks and aren’t taxable. Advance 
billings don’t affect the job’s total 
billings; instead, they update the 
job’s advanced billings totals.

1  Choose My > My Clients.

2  Find the client whose retainer 
billings you wish to schedule.

3  Click the Retainers link.

The Retainer Schedule window 
opens, displaying the client’s 
retainer schedule, retainer billings, 
and balances. If the client has been 
previously billed for retainers, you’ll 
see their billing dates and invoice 
numbers.

4  Enter the retainer’s description 
(i.e., the month) and retainer billing 
amount.

This description is copied to re-
tainer invoices, so the client sees it.

5  Click Save.

Retainers, jobs, and A/R 
invoices

To edit the client’s re-
tainer schedule
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1  The retainer schedule can 
be printed by clicking print.  
Click clear to erase the client’s 
retainer schedule.  

2 This description is copied 
to the retainer invoice when it 
is created.  It can be changed 
anytime as needed.

3  The retainer amount is 
copied to retainer invoices au-
tomatically, but it can be edited 
anytime.  Once a retainer is 
billed, it can’t be changed.

4 The date and invoice number 
are updated when the retainer 
is invoiced, for quick reference.
 
5  The unused retainers amount 
shows the balance of the re-
tainer billings that haven’t been 
applied to invoices yet.  This is 
the amount you can apply as a 
payment to unposted invoices.  
This amount is  usually a liabil-
ity on your financials, since it 
represents unearned income.

6  The unpaid retainers amount 
is the balance due from the 

client for retainer invoices.  As 
the client pays their retainer 
billings, this balance decreases.

7  You can enter default debit 
and credit G/L accounts for 
retainers.  These accounts 
are copied automatically to 
retainer invoices.  If you set up 
retainer payable and receivable 
accounts, you can automatically 
track retainer balances on the 
balance sheet. 

Client Retainer Schedule 

A client’s retainer balance can also be seen in the Clients window in graph form.  To 
access the Retainer Schedule window, double-click on the graph.
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Client Retainer Schedule 
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Monthly budget amounts can be entered for each client account.  These budget numbers are summarized with the 
client’s billings on the Budget Recap report. The Budgets window shows the year’s current billings (including sales 
tax). The Client Budget Recap shows billings for the current fiscal year, You’ll see the year’s invoices subtotaled by 
period, compared with the monthly budget you’ve entered for the client.  This report is only available if  you’ve entered 
budgets for the client; if not, you’ll see a simple invoice list instead.  

Client Budgets 

Client Budgets

1  Clicking on the graph button 
displays a colorful bar graph.

2  To print the graph and bud-
get numbers simply click on the 
print button.

3  Client budgets can be 
entered for each period of the 
current accounting year.   

4  The remaining amount shows 
how much of the budget has 
not been used.

5  The client budget vs actual 

graph shows visually the client’s 
monthly billing totals compared 
the monthly budget amounts 
entered for a client.

Budgets entered into the Client Budgets window are used on the View Budget Recap 
report found under the view>point pop-up menu.  
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While Clients & Profits keeps track of each client’s billings forever, the Client Statistics window conveniently graphs 
the last two years billings.  The Stats window is a great place for account people and agency principals to see a snap-
shot of a client’s billing. The Client Statistics window shows the billings by quarter, using invoice totals posted in Ac-
counts Receivable. For each quarter you’ll see the total billings, the percent of total billings, and the average payment 
information.

Client Statistics

The Client Statistics window and the report don’t show the client’s profitability, so are 
relatively safe to show to clients and agency staff members. 
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1  To see the client quarterly 
billings graph, click on the 
update graph button.  

2  To print the Client Stats 
report, click on the print button.

3  The Client Stats window can 
show statistics for this year or 
last year.  To select which year 
you want to see stats for, use 
the show pop-up menu.

4  The quarterly billings amount 
is the sum of the invoices for 
the three periods that make 

up each quarter. The percent 
field lets you easily see trends 
in each client’s billing. It can 
help you see the highs and lows 
for each client, helping you 
better plan next year’s budget 
and cash flow. The avg pay 
number counts the number of 
days the client needed to pay 
off each invoice added during 
the quarter. You can use this 
information to analyze how 
quickly or how slowly a client 
is paying their invoices from 
quarter to quarter. It’s a great 
way to spot clients whose pay-

ments are slowing down—a sure 
danger sign that the account is 
in trouble. 

5  The total number of jobs 
opened during each quarter are 
shown for comparison. The ratio 
of jobs opened to total billings 
can provide an interesting in-
sight into the client’s work from 
quarter to quarter (i.e., more 
jobs with the same billings 
means those jobs were smaller, 
etc.).

6  The clients quarterly billings 
graph shows visually what the 
billings were for the client per 
quarter.  

Client Statistics
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Client Alerts

Client alerts are customizable, on-line warnings that appear when you add jobs, billings, or payments for a cli-
ent. They’re optional, and can be changed anytime. These alerts don’t stop anyone from working with this client; 
instead, they simply warn the user regarding something about this client. For example, the job alert can inform 
users to use a certain status code, markup, or spec sheet. Or, the billing alert can remind users how to compose an 
invoice. 

Alerts are unique to each client. They can be set up to prompt the user when adding a 
new job, A/R invoice, or client payment. Remember, alerts only warn—not stop—users.

Client Alerts

1  Since alerts are custom-
ized for each client, the name 
of the client appears here for 
reference.

2  Three kinds of events trigger 
an automatic e-mail: when a 
client opens a new job, when a 
client is invoiced, and when a 
client payment is added. The 
e-mail message itself is cus-
tomizable for each client and 
each kind of event.  Click the 
New Job Alert! button to add 
a customized message, which 
will pop up on the user’s screen 

when they add a new job for the 
client.  

3  To add a customized alert 
that pops up when an Accounts 
Receivable invoice is added, 
click on the A/R Alert! button.

4  You can add a customized 
alert  for client payments by 
clicking on the Payment Alert! 
button.  This alert will pop 
up when a client payment is 
added. 

5  Enter the message here. 
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You’ll have plenty of room to 
type whatever you want, but 
remember—the staffer has to 
read it too! 
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Client E-mail

If Clients & Profits is connected to an SMTP-based mail server, it can send electronic mail when a client opens a job, 
is billed, or makes a client payment. Each client can have its own special e-mail settings, which Clients & Profits uses 
to automatically notify the client’s account manager or agency principal. These messages are sent via the internet to 
e-mail programs such as Netscape Mail, Microsoft Outlook, Eudora, etc. It enables a staff member to keep up to date 
about a client’s new jobs, billing, and payments without actually using Clients & Profits. 

Client E-mail

1  Since alerts are custom-
ized for each client, the name 
of the client appears here for 
reference.

2  The job e-mail will send and 
e-mail message whenever a new 
job is opened for this client.

3  The A/R e-mail will send an 
e-mail message when this client 
is billed.

4  The payment e-mail is 
sent when this client pays an 
invoice.

5  The e-mail message itself 
is customizable for each client 
and each kind of event (e.g., 
“here’s a new job!” or “the cli-
ent just paid!”).

6  Each message can be sent 
to one or more Clients & Profits 
staff members. For example, 
the “new job” e-mail can be 
sent to the accounting depart-
ment, while the “payment” 
e-mail might be sent to the 
agency principal.

C&P e-mail can be sent to e-mail-enabled cell phones, papers, and PDAs. Each mes-
sage is unique to each client.
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Sales>Maker

Sales>Maker

1  Sales actions can be easily 
added, edited, and deleted from 
the Sales > Maker window.  To 
add  a new sales action, click 
on the add button.  To edit a 
sales action, click on the edit 
button.  To delete a sales ac-
tion, click delete.

2  To schedule a campaign for 
future sales follow-up actions, 
click on the schedule campaign 
button.   

3  To print a hard-copy printout 
of a list of sales actions, click 
on the print list button.
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4  There are several types of 
sales actions that can be sent 
to the client.  Click on the sales 
letters link to view, add, edit, 
clone,  delete, or print a list of 
current and expired sales let-
ters. Click on the sales e-mails 
link to view, add, edit, clone, 
delete, or print a list of  cur-
rent and expired sales e-mails.  
Click on the call scripts link to 
view, add, edit, clone, delete, 
or print a list of current and 
expired sales calls.  

5  Dozens of campaigns can be 

added for a client.  Campaigns 
make scheduling  follow-up 
sales actions easy.  To view, 
add, edit, clone, delete, or print 
a list of campaigns, click on the 
campaign link.

6  Every sales action for a client 
are listed by date, but the sort 
can be changed by clicking on 
any column heading.  

y

The Sales>Maker is part of Clients & Profits’ client relationship manager. It lets marketing directors and business de-
velopment managers create integrated marketing campaigns that include printed sales letters, follow up e-mail, and 
script-based telemarketing. Automatic sales campaigns can be scheduled for individual clients and their contacts.  

The Sales>Maker keeps track of all your standard sales letters, e-mails, call scripts, 
and campaigns in one place for everyone in Account Service to use.
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Sales letters, e-mails, and call scripts must be approved before they can be used on 
campaigns. Every piece has an expiration that keeps it from being used too long.

1  From the pop-up show menu, 
choose either expired or current 
letter.   

2  All the the letters entered 
into Clients & Profits are listed 
here. To view the letter, just 
click on its letter name.

3  When adding a new letter, 
give it a descriptive name so 
you can easily find in in the 
letters list.

4  The initials of the person 
who entered the letter automati-
cally appear in the author field.

5  When the letter is approved 
by a user with the right access 
privileges, their initials will ap-
pear here.

6  Enter a description about the 
letter’s purpose here.

7  Enter the effective dates 
for the letter here to prevent 
an old letter from being used 
inadvertently.

8  Enter the letter’s subject 
here.  The subject prints on the 
letter.
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9  Enter the body of the letter 
here.  You can type it directly 
into Clients & Profits, or paste 
it from a word processing ap-
plication.

10  Enter the letter’s postscript 
here, including “P.S.”

11  To see how the letter will 
look when printed, click the 
print preview button.  The client 
address won’t print; instead, 
you’ll see several lines for data.

Once created and approved, a sales campaign can be scheduled for individual client 
contacts. Campaigns can be used repeatedly for different contacts. 

a
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Sales>Maker (con’t)

Sales>Maker

Sales campaigns are scheduled for specific client contacts, giving each sales piece a personal touch. This also allows 
for different contacts to get different sales campaigns, each running concurrently or at different times. All of the 
day’s scheduled sales letters, e-mails, and calls are processed together when someone runs the Sales>Maker Follow-
ups.  
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1  Since campaigns are scheduled 
for specific clients, the client name 
fills in automatically.

2  Enter the initials for the staffer 
who will be responsible for handing 
the sales campaign. This person’s 
name will appear on printed letters. 

3  Choose the client contact from 
the pop-up menu. 

4  Enter the date on which the cam-
paign will start. Clients & Profits will 
automatically schedule the follow-up 
pieces (from your campaign) based 
on this start date.

5  Choose the campaign from the 
pop-up campaign menu.  A descrip-
tion of the campaign appears below 
the menu.

6  The follow-ups scheduled for the 
campaign are listed here for easy 
reference.

Once added, the campaign can be assigned to many different clients and client con-
tacts—and used several times.
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Clicking the toolbar buttons will print any unsent sales letter, send any unsent sales 
e-mail, and print the day’s call scripts.

1  To add a sales letter, click 
the add button. To edit a sales 
letter, select it from the list, 
then click the edit button.

2  Delete a sales letter by se-
lecting it in the list below, then 
click the delete button.   

3  To schedule a campaign, 
click the schedule button.

4  Sales>Maker follow-up report 
are accessible using the print 
report button.

5  The client’s name appears 
here for reference. 

6  Sales letters, e-mails, call 
scripts, and campaigns can be 
accessed here by clicking on 
the appropriate link.

7  Every sales action for a client 
are listed by date, but the sort 
can be changed by clicking on 
any column heading.  This at-a-
glance screen includes the kind 
of action, which staffer in the 
agency the action is from, to 

The Sales>Maker Follow-up window lists all of today’s scheduled sales letters, 
e-mails, and calls in chronological order, making it easy for account executives to 
review the day’s follow-ups. 
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which client contact it’s going, 
which sales follow-up it is, and 
which campaign the follow-up 
is linked to.
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Billing/Accounts Receivable

Everything you do for a client is billed by adding an invoice into Accounts 
Receivable. Clients can be billed for anything you do—whether you’re billing 
an estimate, an advance, a retainer, a service charge, or a job’s final costs. 
A/R invoices are seamlessly integrated with jobs and costs, so billing is 
particularly quick and easy—and can be mostly automatic.

Every kind of client invoice—including deposits, retainers, advances, credits, 
and discounts—should be added into Accounts Receivable.  Invoices have one 
or more line items, which contain the actual billing amounts. Every task on a 
job can be billed as a separate line item on an invoice, providing your clients 
with a clear, detailed billing—one that looks like their estimate.

Invoices can be created for job tickets, anytime, one at a time or all jobs 
at once. All you need to know is the job number; Clients & Profits X copies 
the job’s tasks, descriptions, and unbilled amounts to the invoice automati-
cally. The printed invoice shows the job’s details, such as specifications, 
contacts, and billing information.

■  A job can be billed at anytime, as many times as needed. An invoice can 
bill one job ticket, or contain billings for many different jobs and tasks—even 
jobs for different clients.   

Billing is one of the job’s most important steps. It summarizes all of the work 
you’ve done on a job—including payables, time, checks, and expenses—on 
a simple, concise printed invoice. Invoices can be added at the end of the 
month, or throughout the month as jobs are completed.  Billing works like 
this:  

1)  Unbilled jobs are reviewed on work in progress reports to see what’s ready 
to bill; 

2)  Account executives can adjust unbilled amounts, if needed, to fine-tune 
what will be billed. Costs, time, and expenses can be transferred between 
jobs to the same task;

3)  From these work in progress reports, invoices are added for each job’s un-
billed tasks. The auto-bill option can bill these jobs automatically in one step; 

4)  These new invoices are proofed, edited, then posted.  Posting updates the 
client’s balance, job totals, and the financial statements; 

5)  The new invoices are printed, then mailed to clients; 

6)  When the client sends a payment, it is added into Client Payments and 
applied to these unpaid invoices. 

This completes the billing cycle. Everything you bill affects the client account 
and the General Ledger when invoices are posted. Invoices are posted to 
update clients, jobs, and the General Ledger. Posting an A/R invoice creates 
G/L journal entries automatically. The invoice’s total makes a debit entry, 
usually updating the A/R account; each invoice line item makes a credit 

Billing/Accounts Receivable

entry, usually for an income account. Posted invoices appear on job reports, 
billing reports, statements, and client aging reports.  

Where do billing amounts come from?

An invoice’s billing amounts come from job tasks.  Each job task keeps a 
running total of its costs, time, checks, and expenses from the day the job 
began.  The job task’s unbilled balance shows its unbilled gross costs (which 
includes markups, commissions, and billing rates) less what’s been billed 
before.  

Job costs aren’t literally billed on the invoice. Instead, the invoice bills the 
job’s tasks—specifically, each task’s unbilled amount. When you bill a job, 
every task that has unbilled costs can appear on the invoice (either automati-
cally or manually, your choice). The invoice’s billing amount is copied from 
the job task’s unbilled amount. So clients don’t see every cost, time entry, 
and expense on invoices; instead, they only see job tasks. 

You can freely change the invoice’s billing amounts. The job’s costs are unaf-
fected, giving you the flexibility to bill any amount you wish without making 
complex, time-consuming adjusting entries.

How do I know what to bill?

Job tickets keep running balances of billings and unbilled costs, so knowing 
what’s to be billed at any point is easy: just look at the job ticket. Instead of 
reviewing jobs separately, work in progress reports search your database for 
unbilled jobs. 

WIP reports make it easy to pinpoint which jobs need to be billed now, which 
is especially useful when there are hundreds of open jobs. Work in progress 
reports select jobs by status. A job has a different production and billing sta-
tus, for flexibility. Billing status can be used by account executives to track 
billable jobs, without interfering with the production manager’s job status. 

Before billing, WIP reports can be distributed to your various account execu-
tives for review. Once the unbilled jobs have been adjusted as needed, these 
reports can be used as checklists for the month’s invoicing.

Credits, adjustments, and finance charges

Credits can be made for a client by entering an invoice with negative billing 
amounts. When a credit invoice is added as a job billing, the credits will re-
duce the amount billed on the job ticket; if not, the credit will only affect the 
client balance and the General Ledger. Credits, as well as finance charges, 
can also be applied when the client payment is added (which doesn’t affect 
the job either). Finance charges can also be billed separately.
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A/R Features

Feature How it works, how it’s used

When a job ticket is referenced on a cost or billing, the job ticket is updated when the 
invoice or check is posted to the G/L. So the job tracks what needs to be billed and what’s 
already been billed. 

The amount to be billed is copied from the job ticket to the invoice automatically. 

There’s a billing style for every need. Billing types include estimate, progress/final, multi-job, 
media, retainer, advance, miscellaneous, finance charge, and job billing.

Options allow you to show more or less detail to customize the client’s invoice. Tasks can be 
rolled up, grouped, or totaled with the group and hidden. For more detail, the description or 
hours billed can be included. The estimate and previous billings can also be shown as an 
option.

The Billing Worksheet shows which costs are billed on the invoice. The amounts, per cost, 
can be edited as long as the total of the invoice total remains the same.

Up to two sales tax rates can be entered on each task. The sales tax account(s) to be cred-
ited and the rates are copied from the client account when the job is open.

Miscellaneous or finance charge invoices update the client account, but don’t affect the job.

Retainers are deposits from clients which do not update the job. When the job is billed, the 
retainer is applied to it. Advance billings are deposits for a specific job, and are applied to 
the same job when it is billed.

Up to five copies of each invoice can be printed without using expensive multipart forms.

The diary records the when, where, and who was involved for major events or meetings.  
Because the  diary is easily accessed, details of conversations and events are preserved.  The 
record  can also be e-mailed for streamlined communication.

Integrated with job tickets

Automatic billing

Flexible billing styles

Invoice options

Billing worksheet

Two sales tax rates

Non-job invoices

Retainers and advances

Distribution copies

Client diary

A/R Features
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When do I bill something?

There are no real rules when it comes to billing in Clients & Profits.  Any kind 
of invoice can be added, posted, and printed anytime during the month.  A 
job can be billed when it is opened, using its estimate (or any percentage of 
its estimate).  Jobs can be billed progressively, or at completion.  

Invoices can be added for anything that needs billing, whether or not it 
involves a job.  This means you can bill client retainers, finance charges, 
consulting fees, and more where no job exists.  Whatever way you choose to 
bill, jobs always remember what you’ve billed so far.  The Job Ticket window 
shows the job’s billings and unbilled totals.  You can see at a glance what’s 
to be billed on a job ticket

Invoices and Work in Progress 

Every job cost remembers when it was billed, including the invoice number, 
date, and billed amount.  Costs are billed when the invoice is created, 
automatically.  

The process starts when a cost is added:  All job costs are marked as unbilled 
(unless the job task is unbillable).  When the job is billed, its unbilled 
amount is copied to the invoice—task by task—where you can change it.  
When the invoice is saved, the billing amount for each task is applied to its 
costs—starting with the oldest first, until no billing amount remains.  The 
costs that aren’t billed remain on the work in progress report, providing the 
dollar amount of your unbilled costs for your financial statements.  It’s all 
automatic, so there’s very little you need to do.

Sales Tax

Sales tax is calculated automatically on invoices.  Sales tax is based on two 
factors:  the client’s sales tax rate, and whether or not the invoice’s billing 
amounts are taxable.  Two different sales taxes can be tracked, such as a lo-
cal sales tax and a state sales tax.  A sales tax report shows invoices and tax 
you have billed your clients. 

There are standard sales tax rates, names, and liability accounts in Prefer-
ences.  Job tasks are set as taxable/nontaxable in the Task Table.  Tax rates 
aren’t part of the job task; instead, they are part of the client account.  The 
client sales tax rate is copied to new invoices, but can be changed.  Changing 
the invoice’s sales tax rates doesn’t affect the client account.  When the 
invoice is posted, sales tax will be calculated using the invoice’s rates—not 
the rates found in the client account.  Taxable settings are copied from the 
job task to the invoice, where they can be changed.  

Making a billing amount taxable (or not taxable) only affects that invoice.  
Sales tax isn’t calculated until posting.  Once posted, the sales tax rate and 
account can’t be changed.  Posting creates journal entries that credit your 
sales tax liability accounts, which appear on your balance sheet.   When 

Billing/Accounts Receivable

you write a check to pay your sales tax, the check should debit the sales tax 
liability account.

Billing hints, tips, and shortcuts

■  A Progress/Final Billing invoice is the fastest way to bill a job’s costs 
completely.  This option creates the invoice for one job, copying the billing 
amounts and description from each job task in one step.

■  Using the auto-billing option for one client can instantly add invoices for 
the client’s unbilled jobs, without time-consuming data entry.

■  The job’s specifications can be shown on the invoice by checking the Show 
Job Specs option, instead of retyping them onto the invoice.

■  The invoice’s credit G/L accounts, which track income on the financial 
statements, are copied from the job tasks.  Job tasks, in turn, get their cGLs 
from the Task Table.  If you set up your default cGL accounts on the Task 
Table, you won’t have to worry about the G/L accounts on new invoices, sav-
ing time and making your reports more accurate.

■  The billing address can be changed on the invoice itself without affecting 
the client account or other invoices.

■  A job can be billed to any client.  To bill a different client, simply enter a 
new client number over the old number.  The jobs on the invoice will show 
the right billings, even though a different client got the bill.

A/R invoices and client payments

Clients & Profits X makes it easy to view the payments a client makes on its 
invoices. The invoice’s unpaid balance due appears at top-right corner of the 
Accounts Receivable window. It is updated automatically every time a client 
payment is posted. An invoice’s payment history can be viewed by clicking 
the Payments button on the A/R window, which opens the Client Payments 
window. The Client Payments window lists the invoice’s payments, oldest 
first. For each payment you’ll see the date the payment was added, who 
added the payment, the client’s check number, and any discounts taken. A 
list of an invoice’s payments can be printed by clicking the Print button.

Billing/Accounts Receivable (con’t)
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Billing Types

Billing Types

Job billings lets you create an invoice by selecting any job’s tasks.

Advances bill jobs from their estimates, before work has begun. Tasks aren’t billed; 
instead, the client only sees an advance billing amount.  You can bill all or part of the 
estimate.  The job’s total billings aren’t affected; instead, it updates the job’s advance 
billing total.  Advance billings can be applied like a payment to later invoices.  Addi-
tionally, they don’t affect income, instead they credit a liability account (e.g., unearned 
income).

Invoices a job’s unbilled tasks in one step.

WIP billing lets you bill unbilled job costs for any user-defined time period, such as a 
month. The WIP billing window lists costs one-by-one, prompting you to choose which 
ones should be billed on the invoice. When the invoice is saved, the selected costs will 
be billed together by job task.

Estimate billings invoice a job’s estimates, showing tasks. Unlike advances, they 
increase the job’s billed totals.

This option lists unbilled insertion orders or broadcast orders.  Each insertion appears 
as a separate billing amount, showing its publication, issue date, ad#/caption, and 
gross cost.

This option lets you bill one client for one or more jobs and their tasks.

This billing type invoices clients for non-job charges like consulting fees.

Retainers bill clients for account service fees, based on a schedule.  They don’t affect 
jobs.  Retainers can be applied as payments to upcoming invoices.  Additionally, they 
don’t affect income, instead they credit a liability account (e.g., deposits).

This option invoices clients for non-job finance charges.

Job Billing

Advance Billing

Progress/Final Billing

WIP Billing

Estimate Billing

Media Billing

Multi-job Billing

Miscellaneous

Retainer

Finance Charge

Billing type: How it works:
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The Billing/Accounts Receivable Window

progress/final billing, etc.), 
choose Edit > Add New Invoice.  
Clicking on the edit button lets 
you edit the billing’s invoice 
description. If the billing is un-
posted you can edit the client, 
invoice date, period, payment 
terms, due date, description, 
dGL, contacts, AE/team, PO 
number, and sales tax rates.  
If the billing has already been 
posted, only the description 
can be edited.  To change 
billing amounts, click on the 
edit amounts button.  Billing 
amounts can be edited for only 

1  Use the arrow toolbar 
buttons to scroll through the 
previous and next accounts 
receivable invoices.

2  To automatically bill clients 
or projects for selected unbilled 
job tickets, click on the auto-
bill button.  

3  Accounts Receivable invoices 
can be easily added, edited, 
and deleted.  To add a new job 
billing invoice, click on the add 
button. To add another type of 
billing (i.e., estimate billing, 

unposted invoices.  Remember 
that changing an invoice line 
item’s billing amount doesn’t 
change the cost’s billing 
information for the task.  If you 
change a billing amount for a 
job billing, you may need to ad-
just your cost’s billed amount in 
the billing worksheet.  To delete 
a billing, click on the delete 
button.  Only unposted invoices 
can be deleted.  If the invoice 
has already been posted you 
can either unpost  the invoice 
and then delete it or you can 
add another invoice that adjusts 
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Double-click on a billing amount to edit the task’s description.  The task code can’t be 
changed.  Only the task description appears on the printed invoice.
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the account balance.

4  Amounts can be easily added 
and removed from an unposted 
billing using the add amount 
and remove amount buttons.  

5  Use the print reports and 
print invoices buttons to print 
Accounts Receivable reports 
and invoices.

6  Enter the invoice number 
here to find a billing.  Or use 
the find more link to find 
invoices by sequence, invoice 
number, job number, client 
number, date, PO number, or 
due date.

7  Use the history pop-up menu 
to jump to a previously viewed 
billing.

8  Click on these links to 
quickly see the most important 
parts of an invoice, then make 
changes.  Click on the descrip-
tion link to view or edit the 
billing’s client, invoice date, pe-
riod, payment terms, due date, 
description, dGL, contacts, AE/
team, po number, and sales tax 
rates.  If the billing has already 
been posted, only the descrip-
tion can be edited.  Click on the 
options link to view or edit the 
billing’s display options, copies 
to names, finance charge, or 

billing address.  Click on the 
worksheet link to view or edit 
the billing’s worksheet, which 
lists the billing’s job costs.  
Click on the payments link to 
view all client payments posted 
for this billing.  Click the client 
diary link to add, view, or print 
the client’s diary entries.

9  Invoices are automatically 
numbered or you can enter your 
own invoice number. The next 
invoice number can be set in 
Preferences. It can contain up 
to 10 numbers.  

10  The billing type indicates 
what kind of charges were billed 
on this invoice (e.g., estimate, 
progress/final, media, advance, 
retainer, miscellaneous, etc.). 

11  The added by initials show 
which user added the invoice.  

12  Every invoice includes one 
client number, one or more job 
numbers, a description, and an 
invoice date. This information 
appears on the printed invoice. 

13  The client’s PO number is 
copied from the job ticket. The 
payment terms are copied from 
the client account. Both appear 
on the printed invoice. 

14  The due date is the date 

on which the invoice’s payment 
is expected, and is used by the 
Cash Flash report. Clients never 
see the due date.

15  The Balance due shows the 
invoice’s total charges (includ-
ing sales tax) less any retainer, 
advance, or client payments. 
The posted date shows when 
the invoice was finalized and 
posted to the G/L. Posting 
updates the client account, jobs 
and tasks, and the General Led-
ger. Posting an invoice updates 
the G/L based on its accounting 
period. 

16  The days due box shows a 
countdown of how many days 
are left until the invoice reaches 
it’s due date.  

17  Each invoice line item can 
include a job, task, description, 
and billing amount. Double-
click on a line item to see and 
edit a billing amount.

18  If a retainer or advance 
payment was applied to an 
invoice, its description and 
amount appear at the bottom 
of the window—and the printed 
invoice.

19  The total amount of the 
billing includes sales tax plus 
the total of all invoice line item 
amounts.  

The Delete All Unposted Invoices can be used to delete any kind of invoice—not just au-
tomatic billings—regardless of how it was added. In fact, it will delete every A/R invoice 
that isn’t posted. 
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Job Billing

Job Billing
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1  Invoices are numbered 
automatically based on a user-
defined number in Preferences. 
The invoice number can be 
changed by selecting it and 
then entering your own number.  
The invoice number appears on 
all windows, reports, and forms.  

2  The job number indicates 
which job was billed on an 
invoice.   The last-used job 
number is used entered auto-
matically as a time saver, but 
it can be changed.  Invoices 
usually bill one job at a time 

(but the multi-job billing type 
lets you bill several on the same 
invoice).

3  An invoice can be billed to 
only one client.  This is the one 
who will eventually pay for the 
invoice.  The client number is 
copied automatically from the 
job, but it can be changed--
which allows you to bill the job 
to a different client.

4  The invoice date appears on 
the printed invoice. It is used 
by the aging reports to calculate 

the age of unpaid invoices.

5  The accounting period speci-
fies which month in the General 
Ledger should be affected when 
an invoice is posted. The 
invoice date and the accounting 
period can be different, for flex-
ibility. This means an invoice 
can be dated in this month, but 
the invoice can be posted to 
next month’s financial period.

6  The due date is the date on 
which payment is expected. It’s 
for internal cash-flow planning 

When a job task is entered, the unbilled amount and billing information from the task 
is copied to the invoice line item.  
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only; the client never sees it. 

7  The client’s purchase 
order and charge number are 
copied from the job ticket. The 
invoice’s payment terms are 
copied from the client account. 
The terms appear on the printed 
invoice. 

8  The debit account, which is 
usually Accounts Receivable, 
is copied from Preferences.  
This account is debited for the 
invoice’s total, including sales 
tax, when the invoice is posted.   

9  Invoice notes explain what 
you’ve  billed.  They appear on 
the printed invoice, above the 
billing amounts.

10  An invoice can include 
dozens of different billing 
amounts, each of which contain 
a job task, billing amounts, 
hours billed, and an income G/L 
account. Billing amounts are 
subtotaled by group, just like 
amounts on printed estimates.

11  The roll up billing amounts 
by task option lets you custom-
ize how billing amounts appear 
on the printed invoice. The 
roll-up option gives you the 
most flexibility in billing, since 
it combines selected tasks into 
another task.

Billing a job for its unbilled costs is the easiest, fastest way to add an invoice.  All  
you need to know is the job number. Since jobs are integrated with billing and ac-
counts receivable, there’s no rekeying to make an invoice.

12  The client’s billing address 
is copied to invoices automati-
cally. Click the billing address 
button to customize the bill-to 
address on this invoice. Click 
the traffic button to update the 
job’s traffic status, including 
milestones, while adding the 
invoice.
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1  Invoices are numbered 
automatically based on a user-
defined number in Preferences. 
The invoice number can be 
changed by selecting it and 
then entering your own number.  
The invoice number appears on 
all windows, reports, and forms.  

2  The job number indicates 
which job was billed on an 
invoice.   The last-used job 
number is used entered auto-
matically as a time saver, but 
it can be changed.  Invoices 
usually bill one job at a time 

e

i

s

q

r

f

w

u

o

a

(but the multi-job billing type 
lets you bill several on the same 
invoice).

3  An invoice can be billed to 
only one client.  This is the one 
who will eventually pay for the 
invoice.  The client number is 
copied automatically from the 
job, but it can be changed—
which allows you to bill the job 
to a different client.

4  The invoice date appears on 
the printed invoice. It is used 
by the aging reports to calculate 

the age of unpaid invoices.

5  The accounting period speci-
fies which month in the General 
Ledger should be affected when 
an invoice is posted. The 
invoice date and the accounting 
period can be different, for flex-
ibility. This means an invoice 
can be dated in this month, but 
the invoice can be posted to 
next month’s financial period.

6  The due date is the date on 
which payment is expected. It’s 
for internal cash-flow planning 

p
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Estimate Billing

Estimate Billing

An estimate billing  is fast (and accurate) because it creates an invoice using the job’s 
estimate amounts, not costs.  All you need to know is the job’s number.

t y
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If you always bill jobs based on a fixed estimate, then you’ll use the estimate billing option 
often. If you generally bill jobs at completion, the estimate billing option is useful when you 
sometimes need to bill a job—or any part of it—up front (such as a big printing job).  

only; the client never sees it. 

7  The client’s purchase 
order and charge number are 
copied from the job ticket. The 
invoice’s payment terms are 
copied from the client account. 
The terms appear on the printed 
invoice. 

8  The debit account, which is 
usually Accounts Receivable, 
is copied from Preferences.  
This account is debited for the 
invoice’s total, including sales 
tax, when the invoice is posted.   

9  Invoice notes explain what 
you’ve  billed.  They appear on 
the printed invoice, above the 
billing amounts.

10 The billing amounts will be 
calculated using a percentage 
of the job’s estimate. Billing 
amounts are copied for every 
task on the estimate. Any por-
tion of the job’s estimate can 
be billed, depending on your 
agreement with the client.

11  Job tasks are billed on 
estimate billings by checking 
the “X” checkbox. If you don’t 
want a particular task to appear 
on this estimate, uncheck it. 
The task’s description, billing 
amount, and income cGL num-
ber can be changed. Editing the 
task’s billing amount does not 
affect its estimate—the change 
only appears on the estimate 
billing.

12   The include change orders 
option causes the task’s change 
order total to be added into its 

billing amount.  

13  The roll up billing amounts 
by task option lets you custom-
ize how billing amounts appear 
on the printed invoice.  The 
roll-up option gives you the 
most flexibility in billing, since 
it combines selected tasks into 
another task.

14  The client’s billing address 
is copied to invoices automati-
cally. Click the billing address 
button to customize the bill-to 
address on this invoice. Click 
the traffic button to update the 
job’s traffic status, including 
milestones, while adding the 
invoice. 
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1  Invoices are numbered 
automatically based on a user-
defined number in Preferences. 
The invoice number can be 
changed by selecting it and 
then entering your own number.  
The invoice number appears on 
all windows, reports, and forms.  

2  The job number indicates 
which job was billed on an 
invoice.   The last-used job 
number is entered automatically 
as a time saver, but it can be 
changed.  Invoices usually bill 
one job at a time (but the multi-

job billing type lets you bill 
several on the same invoice).

3  An invoice can be billed to 
only one client.  This is the one 
who will eventually pay for the 
invoice.  The client number is 
copied automatically from the 
job, but it can be changed--
which allows you to bill the job 
to a different client.

4  The invoice date appears on 
the printed invoice. It is used 
by the aging reports to calculate 
the age of unpaid invoices.

5  The accounting period speci-
fies which month in the General 
Ledger should be affected when 
an invoice is posted. The 
invoice date and the accounting 
period can be different, for flex-
ibility. This means an invoice 
can be dated in this month, but 
the invoice can be posted to 
next month’s financial period.

6  The invoice’s payment terms 
are copied from the client ac-
count. The terms appear on the 
printed invoice.
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Progress/Final Billing

Progress/Final Billing
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A progress/final billing is a faster, easier way to invoice a job’s costs. It’s fast because 
billing amounts are created automatically for the job’s tasks for the job number entered.
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There’s no distinction between a progress billing and a final billing. Both kinds of billings 
are treated the same way:  both create an invoice using the job’s unbilled tasks.  Use the 
progress/final option when you need to bill a job for costs, even if it isn’t finished. 

7  The due date is the date on 
which payment is expected. It’s 
for internal cash-flow planning 
only; the client never sees it. 

8  The debit account, which is 
usually Accounts Receivable, 
is copied from Preferences.  
This account is debited for the 
invoice’s total, including sales 
tax, when the invoice is posted.   

9  Invoice notes explain what 
you’ve  billed.  They appear on 
the printed invoice, above the 
billing amounts.

10  The billing amounts will be 
calculated using a percentage 
of the job’s estimate. Billing 
amounts are copied for every 
task on the estimate. Any por-
tion of the job’s estimate can 
be billed, depending on your 
agreement with the client.

11  The job task’s descrip-
tion, unbilled amount, unbilled 
hours, and cGL are copied to 
the invoice. The billing amount 
is copied from the job task, but 

can be freely modified. You can 
bill any amount, whether the 
job task has costs or not. The 
billing amount will be credited 
to the job task’s cGL (i.e., in-
come) account. The line item’s 
cGL can be changed to a differ-
ent account, if needed, without 
affecting the job task.

12  The include change orders 
option causes the task’s change 
order total to be added into its 
billing amount.  The include 
unbilled POs/IOs option causes 
the task’s unbilled order totals 
to be added into its billing 
amount.  The roll up billing 
amounts by task option lets you 
customize how billing amounts 
appear on the printed invoice.  
The roll-up option gives you the 
most flexibility in billing, since 
it combines selected tasks 
into another task.  The show 
hours billed option will show 
each task’s billed hours on the 
printed invoice.

13  The client’s purchase order 
and charge number are copied 
from the job ticket.  
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WIP Billing

WIP Billing

1  Invoices are numbered 
automatically based on a user-
defined number in Preferences. 
The invoice number can be 
changed by selecting it and 
then entering your own number.  
The invoice number appears on 
all windows, reports, and forms.  

2  The job number indicates 
which job was billed on an 
invoice.   The last-used job 
number is used entered auto-
matically as a time saver, but 
it can be changed.  Invoices 
usually bill one job at a time 

(but the multi-job billing type 
lets you bill several on the same 
invoice).

3  An invoice can be billed to 
only one client.  This is the one 
who will eventually pay for the 
invoice.  The client number is 
copied automatically from the 
job, but it can be changed—
which allows you to bill the job 
to a different client.

4  The invoice date appears on 
the printed invoice. It is used 
by the aging reports to calculate 

the age of unpaid invoices.
5  The accounting period speci-
fies which month in the General 
Ledger should be affected when 
an invoice is posted. The 
invoice date and the accounting 
period can be different, for flex-
ibility. This means an invoice 
can be dated in this month, but 
the invoice can be posted to 
next month’s financial period.

6  The client’s purchase order is  
copied from the job ticket. 

7  The invoice’s payment terms 
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WIP billings are fast and easy. Your unbilled costs are entered automatically based on 
a date range that you specify.    
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are copied from the client ac-
count. The terms appear on the 
printed invoice.

8  The due date is the date on 
which payment is expected. It’s 
for internal cash-flow planning 
only; the client never sees it. 

9  The debit account, which is 
usually Accounts Receivable, 
is copied from Preferences.  
This account is debited for the 
invoice’s total, including sales 
tax, when the invoice is posted. 

10  The  charge number is 
copied from the job ticket.  

11  Unbilled job costs are 
selected from the job ticket for 
a specified date range.  

12  The roll up billing amounts 
by task option lets you custom-
ize how billing amounts appear 
on the printed invoice.  The 
roll-up option gives you the 
most flexibility in billing, since 
it combines selected tasks into 
another task.

What’s the difference between a progress/final billing and a WIP billing?  Progress/final 
billings pull every unbilled costs.  WIP billings only pull unbilled costs for your specified 
date range.  WIP billing makes it easy for you to bill costs for a certain month without 
having to add your billing on the first or last day of the month.  

13  The unbilled job costs that 
are dated within your selected 
date range will be automatically 
listed here with their billing 
detail.  The amounts and hours 
can be edited.  

14  Invoice notes explain what 
you’ve  billed.  They appear on 
the printed invoice, above the 
billing amounts. 
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Multi-job billings can be created to bill for many jobs and tasks on a single invoice.  You can consolidate jobs from 
various clients onto a single invoice—for one client. Multi-job invoices can make billing large companies much 
easier, especially when you do work for many departments or divisions of a corporation. Multi-job invoices also 
work well when one client has a tremendous volume of work to bill at once.

1  Invoices are numbered 
automatically based on a user-
defined number in Preferences. 
The invoice number can be 
changed by selecting it and 
then entering your own number.  
The invoice number appears on 
all windows, reports, and forms.  

2  An invoice can be billed to 
only one client.  This is the one 
who will eventually pay for the 
invoice.  

3  The invoice date appears on 
the printed invoice. It is used 

by the aging reports to calculate 
the age of unpaid invoices.

4  The accounting period speci-
fies which month in the General 
Ledger should be affected when 
an invoice is posted. The 
invoice date and the accounting 
period can be different, for flex-
ibility. This means an invoice 
can be dated in this month, but 
the invoice can be posted to 
next month’s financial period.

5  The due date is the date on 
which payment is expected.  It’s 
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for internal cash-flow planning 
only; the client never sees it.  

6  The client’s purchase order 
and charge number can be 
entered here.  The invoice’s 
payment terms are copied from 
the client account.  They all ap-
pear on the printed invoice.  

7  The debit account, which is 
usually Accounts Receivable, 
is copied from Preferences.  
This account is debited for the 
invoice’s total, including sales 
tax, when the invoice is posted. 

Multi-Job Billing

Multi-Job Billing
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Multi-job billings let you consolidate jobs from various clients onto a single invoice—
for one client. It makes billing large companies with various departments much easier.
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8  Invoice notes explain what 
you’ve  billed.  They appear on 
the printed invoice, above the 
billing amounts.

9  Every invoice line item gets 
a job number. Any client’s jobs 
can be included on multi-job 
billings.

10  Tabbing past the job’s task 
copies its description, unbilled 
amount, unbilled hours, and 
cGL to the invoice. 

11  The billing amount is cop-
ied from the job task, but can 
be freely modified. You can bill 
any amount, whether the job 
task has costs or not.

12  The billing amount will be 
credited to the job task’s cGL 
(i.e., income) account. The line 
item’s cGL can be changed to 
a different account, if needed, 
without affecting the job task.

The printed invoice for a multi-job billing is tightly formatted, so it doesn’t have all 
display options available as do other billing types.  

13  The roll up billing amounts 
by task option lets you custom-
ize how billing amounts appear 
on the printed invoice.  The 
roll-up option gives you the 
most flexibility in billing, since 
it combines selected tasks into 
another task.

14  The client’s billing address 
is copied to invoices automati-
cally. Click the billing address 
button to customize the bill-to 
address on this invoice. Click 
the traffic button to update the 
job’s traffic status, including 
milestones, while adding the 
jobs to the invoice. 
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Media Billing

Media Billing

1  Invoices are numbered 
automatically based on a user-
defined number in Preferences. 
The invoice number can be 
changed by selecting it and 
then entering your own number.  
The invoice number appears on 
all windows, reports, and forms.  

2  An invoice can be billed to 
only one client.  This is the one 
who will eventually pay for the 
invoice.  The client number is 
copied automatically from the 
job, but it can be changed —
which allows you to bill the job 

Billing broadcast, print, interactive, and outdoor orders is a snap—a completed invoice is just a few clicks away.  
There’s nothing to rekey, since invoices are based on media orders.  All you need to know is the client number and the 
run date. 
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to a different client.

3  The invoice date appears on 
the printed invoice. It is used 
by the aging reports to calculate 
the age of unpaid invoices.

4  The accounting period speci-
fies which month in the General 
Ledger should be affected when 
an invoice is posted. The 
invoice date and the accounting 
period can be different, for flex-
ibility. This means an invoice 
can be dated in this month, but 
the invoice can be posted to 

next month’s financial period.

5  The client’s purchase order 
can be entered here.  The 
invoice’s payment terms are 
copied from the client account.  
They both appear on the printed 
invoice.  

6  The debit account, which is 
usually Accounts Receivable, 
is copied from Preferences.  
This account is debited for the 
invoice’s total, including sales 
tax, when the invoice is posted. 

Multi-job billings let you consolidate jobs from various clients onto a single invoice—
for one client. It makes billing large companies with various departments much easier.
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Unlike pre-billings, media billings can be added after insertion or broadcast orders have their 
costs invoiced by the publication/station.  Each media invoice can contain dozens of inser-
tion  or broadcast orders which will each appear as separate billing amounts on the printed 
invoice.

7  The client’s charge number 
can be entered here.  It appears 
on the printed invoice.

8  The due date is the date on 
which payment is expected.  It’s 
for internal cash-flow planning 
only; the client never sees it.  

9  Invoice notes explain what 
you’ve  billed.  They appear on 
the printed invoice, above the 
billing amounts.

10  A media billing can be 
added to bill a client’s insertion 
orders or broadcast orders.

11  If a client pays the media 
directly, it can be billed for 
commission amounts only by 
choosing the bill commission 
only option. Every media buy 
from the insertion or broadcast 
order will appear on the invoice. 
The media commission is calcu-
lated as the difference between 
the media buy’s gross amount 
less its net amount.

12  If you selected to bill the 
client for insertion orders, then 
enter in the space close date 
here.  This is the date that 
unbilled insertion orders will 
be pulled from.  If you selected 
to bill the client for broad-
cast orders, then enter in the 
broadcast month here.  Unbilled 
broadcast orders will be pulled 
for this month only.

1  The Media Billings window 
will list unbilled orders by num-
ber, generally with the oldest 
ones shown first. 

2  Insertion orders and broad-
cast orders are added to media 
invoices by checking the “X” 
checkbox.

17  The order’s publication/
station and ad name/program 
appear here for reference.  The 
ad’s issue date appears on the 
printed invoice. 

3  The media buy’s net and 
gross amounts are shown for 
reference. 

4  Depending on the option 
chosen when the invoice was 
added, the media buy’s gross 
amount, net amount, or com-
mission only amount will be in-
cluded on the invoice as the bill 
amount. You can change the 
media buy’s billing amount by 
entering a new number. Media 
buys that are billed as net not 
gross (i.e., if the “bill net, not 
gross” option was checked) are 

indicated with a small “n” next 
to the amount.
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1  Invoices are numbered 
automatically based on a user-
defined number in Preferences. 
The invoice number can be 
changed by selecting it and 
then entering your own number.  
The invoice number appears on 
all windows, reports, and forms.  

2  A retainer invoice can be 
billed to only one client. 

3  Invoice date appears on the 
printed invoice.  It is used by 
the aging reports to calculate 
the age of unpaid invoices.  

q
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Retainer Billing

Client retainers are special-purpose invoices that bill clients, but don’t count as income.  Instead, retainers are billed 
as deposits against future billings. Retainers can only be billed from each client’s retainer schedule which.   contains 
descriptions and amounts for up to twelve monthly billings. When you add a retainer invoice, you’ll be prompted to 
select a retainer to bill from the client’s schedule copying in all the details from the client account.   When a retainer 
is posted, the balance updates the client’s retainer balance.
  

When a retainer is applied to an unposted invoice, the retainer amount appears after 
the invoice’s line items and billing amounts, sales tax, and grand total.

4  The accounting period speci-
fies which month in the General 
Ledger should be affected when 
an invoice is posted. The 
invoice date and the accounting 
period can be different, for flex-
ibility. This means an invoice 
can be dated in this month, but 
the invoice can be posted to 
next month’s financial period.

5  The client’s purchase order is 
copied from the client account.  

6  The invoice’s payment terms 
are copied from the client ac-

count.  They all appear on the 
printed invoice.  

7  The debit account, which is 
usually Accounts Receivable, is 
copied from the client’s retainer 
schedule.  

8  The credit account, which is 
usually a liability account (e.g., 
deposits), is also copied from 
the client’s retainer schedule. 

9  The due date is the date on 
which payment is expected.  It’s 
for internal cash-flow planning 
only; the client never sees it.
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If a client pays you a flat monthly fee that isn’t applied to job billings, then it shouldn’t be billed as a retainer.  
These fees, which usually cover the client’s account service hours, are really earned income because you won’t 
give the money back if you do no work.

10  To add a retainer billing 
to this invoice, click the “X” 
checkbox for a selected month. 
Previously billed retainers will 
have the checkbox already 
marked.

11  When a scheduled retainer 
is actually billed (by clicking on 
the “X”), its billed date is en-
tered automatically. The billed 
date appears for reference on 
previously billed retainers.
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How it works: When an 
advance billing is posted, a 
debit journal entry is posted 
into Accounts Receivable and 
a credit journal entry is posted 
into Client Advances. Unlike 
retainers, advance billings do 
increase the client’s balance.  
Advance invoices appear on ag-
ing reports, and are paid off in 
Client Payments just like other 
invoices.  

■  Advance billing is only avail-
able in Clients & Profits Pro X 
and Clients & Profits SQL X.

q

Advance Billing

Advance Billing

Advances are special invoices that bill a job’s estimate before the work has started. They are special because the 
billing amounts on advance invoices aren’t considered income; instead, they are counted as unearned revenue, or a 
liability on the financial statements. 

1  Invoices are numbered 
automatically based on a user-
defined number in Preferences. 
The invoice number can be 
changed by selecting it and 
then entering your own number.  
The invoice number appears on 
all windows, reports, and forms.  

2  The job number shows which 
job was billed on the invoice. 
Only one job can be billed on 
each advanced billing.

3   An invoice can be billed to 
only one client.  This is the one 

who will eventually pay for the 
invoice.  The client number is 
copied automatically from the 
job, but it can be changed—
which allows you to bill the job 
to a different client.

4  Invoice date appears on the 
printed invoice.  It is used by 
the aging reports to calculate 
the age of unpaid invoices.  

5  The accounting period speci-
fies which month in the General 
Ledger should be affected when 
an invoice is posted.

Advances act like client retainers, but are associated with one specific job.  They let 
you bill up front for a job, then apply these billings later when the actual costs are 
billed.  
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6  The client’s purchase order 
is copied from the job ticket.  
The invoice’s payment terms are 
copied from the client account.  
They all appear on the printed 
invoice. 

7  The debit account, which is 
usually Accounts Receivable, is 
copied from Preferences. 

8  The due date is the date on 
which payment is expected.  It’s 
for internal cash-flow planning 
only; the client never sees it. 

9  Invoice notes explain what 
you’ve  billed.  They appear on 
the printed invoice, above the 
billing amounts.

10  The estimate and ad-
vance billed-to-date totals are 
copied from the job ticket. Any 
percentage, up to 100%, of this 
job’s estimate can be billed.  
The billing amount is calcu-

The advance billing amount appears on the bottom right side of the Job Snapshot window 
(Production > Job Tickets > view>point > Job Snapshot).  It is the running total of the job’s 
advance billings, less any amounts applied to the job’s invoices. 

lated, based on the estimate, 
by tabbing past the percent-
age.  The advance billing cGL 
account number should be a 
liability account (e.g., unearned 
revenue).

11  To print a copy of the job’s 
estimate at the same time the 
invoice is printed, select the 
option also print estimate with 
this invoice.

12  The client’s billing address 
is copied to invoices automati-
cally. Click the billing address 
button to customize the bill-to 
address on this invoice. Click 
the traffic button to update the 
job’s traffic status, including 
milestones, while adding the 
invoice. 
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Miscellaneous Billing

Miscellaneous Billing

Miscellaneous billings don’t affect jobs. They’re ideal for onetime billings for small 
charges like consulting, royalties, expense reimbursements, and fees.

1  Invoices are numbered 
automatically based on a user-
defined number in Preferences. 
The invoice number can be 
changed by selecting it and 
then entering your own number.  
The invoice number appears on 
all windows, reports, and forms.  

2  An invoice can be billed to 
only one client.  This is the one 
who will eventually pay for the 
invoice.  

3  The invoice date appears on 
the printed invoice. It is used 

by the aging reports to calculate 
the age of unpaid invoices.

4  The accounting period speci-
fies which month in the General 
Ledger should be affected when 
an invoice is posted. The 
invoice date and the accounting 
period can be different, for flex-
ibility. This means an invoice 
can be dated in this month, but 
the invoice can be posted to 
next month’s financial period.

5  The client’s purchase order  
can be entered here.  The 

invoice’s payment terms are 
copied from the client account.  
They both appear on the printed 
invoice.  

6  The debit account, which is 
usually Accounts Receivable, 
is copied from Preferences.  
This account is debited for the 
invoice’s total when the invoice 
is posted. 

7  The client’s charge number 
can be entered here.  It appears 
on the printed invoice.
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Invoices don’t have to reference a job numbers or tasks. These billings, called miscellaneous invoices (as op-
posed to job invoices), let you bill clients for non-job charges such as consulting fees, commissions, and service 
charges—as well as credits and adjustments—without affecting job tickets.  

8  The due date is the date on 
which payment is expected.  It’s 
for internal cash-flow planning 
only; the client never sees it. 

9  Invoice notes explain what 
you’ve  billed.  They appear on 
the printed invoice, above the 
billing amounts.

10  The description field can 
be used to describe the billing 
amount.  It appears in the body 
of the printed invoice.  When 
the invoice is posted, this 
description becomes the credit 
journal entry’s description in 
the General Ledger.

11  This is the amount the 
invoice is being billed for.

12  The credit G/L account is 
entered automatically from pref-
erences, but it can be changed.  

13  The client’s billing address 
is copied to invoices automati-
cally. Click the billing address 
button to customize the bill-to 
address on this invoice.
 

Miscellaneous Billing
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Finance Charge Billing

Finance Charge Billing

1  Invoices are numbered 
automatically based on a user-
defined number in Preferences. 
The invoice number can be 
changed by selecting it and 
then entering your own number.  
The invoice number appears on 
all windows, reports, and forms.  

2  An invoice can be billed to 
only one client.  This is the one 
who will eventually pay for the 
invoice.  

3  The invoice date appears on 
the printed invoice. It is used by 

the aging reports to calculate 
the age of unpaid invoices.

4  The accounting period speci-
fies which month in the General 
Ledger should be affected when 
an invoice is posted. The 
invoice date and the accounting 
period can be different, for flex-
ibility. This means an invoice 
can be dated in this month, but 
the invoice can be posted to 
next month’s financial period.

5  The client’s purchase order  
can be entered here.  The 

invoice’s payment terms are 
copied from the client account.  
They both appear on the printed 
invoice.  

6  The debit account, which is 
usually Accounts Receivable, 
is copied from Preferences.  
This account is debited for the 
invoice’s total when the invoice 
is posted. 

7  The client’s charge number 
can be entered here.  It appears 
on the printed invoice.

Finance charge billings are used to bill a late-paying client for finance or service 
charges. They look like regular invoices, and aren’t handled differently by Clients & 
Profits. 
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While finance charges are calculated on aging reports, they aren’t automatically 
billed to clients. Instead, separate finance charge invoices are added then printed for 
the client.

8  The due date is the date on 
which payment is expected.  It’s 
for internal cash-flow planning 
only; the client never sees it. 

9  Invoice notes explain what 
you’ve  billed.  They appear on 
the printed invoice, above the 
billing amounts.

10  The description field can 
be used to describe the billing 
amount.  It appears in the body 
of the printed invoice.  When 
the invoice is posted, this 
description becomes the credit 
journal entry’s description in 
the General Ledger.

11  This is the amount the 
invoice is being billed for.

12  The credit G/L account is 
entered automatically from pref-
erences, but it can be changed.  

13  The client’s billing address 
is copied to invoices automati-
cally. Click the billing address 
button to customize the bill-to 
address on this invoice.

Finance Charge Billing
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Automatic Job Billing

Automatic Job Billing

Clients & Profits X provides a unique feature that creates invoices automatically for all of your unbilled jobs.  It’s the 
same result as if you’d entered an invoice for each of your unbilled jobs. Instead, auto-billing does the work for you. 
The auto-billing process is simple: unbilled jobs are chosen by production or billing status. Invoices are made auto-
matically, including a line item for every unbilled task on the job ticket. There’s no retyping.

1  Choose production status 
or billing status from the from 
pop-up menu, then enter a 
range of status codes. To bill all 
jobs with unbilled tasks, enter 
the status range of 0 to 999. 
This range of status codes will 
include jobs without a billing 
status. To only bill jobs with a 
specific status, enter a more 
limited range of status codes 
(e.g., 30 - 50).

2  Choose client or project 
from the and for pop-up menu, 
then enter a client number or 

project code.  Unbilled jobs 
can be selected for one client 
or project or all clients and all 
projects. This option lets you 
easily bill one client’s unbilled 
at the same time. It also gives 
you the option to easily bill one 
project’s jobs together on the 
same invoice.

3  The invoice date is the date 
that appears on the printed in-
voice.  The client sees this date 
as the date of the billing.  It is 
used by the aging reports to cal-
culate an invoice’s age (i.e., 30 

days, 60 days, 90 days).  The 
date defaults to today, but can 
be changed. It does not affect 
the posted date.

4  The next invoice number 
lets you set the numbering 
sequence for this batch of 
invoices.  The next number, 
based on the last invoice, is 
entered automatically.  If the 
last invoice number contained 
letters, the next number can’t 
increment-—and you’ll have to 
enter your own number.

When auto-billing, costs are billed automatically as invoices are saved.  Use the 
Billing Worksheet window to change billing amounts on a job cost before posting an 
invoice.  
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If for some reason you want to delete all of the auto-billed invoices and start the process 
over again, use the Delete All Unposted A/R command.  Keep in mind that it will delete 
all unposted invoices, not just your automatic billings.  

5  The accounting period speci-
fies which month in the General 
Ledger should be affected when 
an invoice is posted. The 
invoice date and the accounting 
period can be different, for flex-
ibility. This means an invoice 
can be dated in this month, but 
the invoice can be posted to 
next month’s financial period.

6  Instead of creating a sepa-
rate invoice for each job with 
unbilled amounts, the make 
one invoice per client option 
will combine the client’s jobs 
on one invoice. 

7  To show the hours billed on 
the printed invoices, select the 
show hours billed option.

8  Clicking  OK automatically 
creates the invoices.  The auto-
bill function creates invoices by 
first compiling a list of unbilled 
jobs, based on your selections. 
The unbilled job’s tasks are 
analyzed, then invoice billing 
amounts are saved. These 

line items are then compiled 
together by job number to com-
plete the finished invoices.
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The Billing Worksheet

The Billing Worksheet

Although the job’s costs don’t actually appear on the invoice, they are billed 
when you add an invoice. This means that you’ll always know when vendor 
invoices, time entries, checks, and expenses were billed to a client, the 
amount billed, and the client’s invoice number. Because Clients & Profits X 
automatically applies what you’re billing to job costs, extra data entry isn’t 
needed. Instead, billing amounts are applied to each task’s costs, oldest first.  

Every cost tracks when it was billed, the invoice number, the invoice date, 
and the amount billed. This information makes it easy for anyone in the 
agency to see when (or if) a cost was billed. Every cost window (A/P, check-
book, time sheets, and expenses) shows billing information.

■   Client billings are based on job tasks, not literally the job’s costs. This 
means when you bill a job, the amount that’s billed is copied from the job 
task. The job task gets the unbilled total from job costs, but it’s a separate 
amount. This gives you the ability to bill for more or less than the job’s 
costs, without making adjusting cost entries.  Instead, you simply bill what 
you want to bill—and Clients & Profits keeps track of the unbilled work in 
progress automatically.

The automatic cost billing will work for most of your invoices, since most bill-
ings are straightforward. However, in some cases you may need to selectively 
bill some costs, but not others. So the invoice’s Billing Worksheet window 
lets you change how the billings are distributed to the job’s costs.

■   Editing the Billing Worksheet has no direct effect on your General Ledger. 
That’s because costs update the General Ledger when they are posted as 
accounts payable and checks.  

How does billing work in progress affect the General 
Ledger?

Costs from Accounts Payable or from the Checkbook debit the G/L when the 
vendor invoices or checks are posted. Posting vendor invoices credits the A/P 
liability account, while posting checks credits the Cash asset account.

Posting client invoices credits your income account only. A separate credit 
JE is posted for each line item/billing amount on your invoice. The invoice 
total debits your A/R asset account. These are the only G/L entries posted by 
Accounts Receivable.  

The journal entries posted from A/P and A/R are automatic. You may need to 
make adjusting G/L entries to accommodate complete inventory account-
ing for job costs. You’ve got complete control over which debit and credit 
accounts are used.

Since WIP reports show costs by billing status (e.g., unbilled, unbillable, 
billed, on-hold, partial, etc.) you can easily run a month-end report showing 
everything billed, unbilled, etc. These reports can be used as the source for 
your inventory journal entries.  For more information see the WIP FAQ on the 

Clients & Profits web site.

How billing amounts are applied to a job’s costs

The distribution of billing amounts to job costs is automatic.  Costs are updat-
ed as billing amounts are saved (e.g., after a new task is added to an invoice). 
You’ll see a progress message while the line item is being saved.  At this 
point, the line item’s billing amount is applied to the task’s oldest, unbilled 
cost first.  Then billing amounts are applied methodically to the next-oldest 
cost, and so on until there is no billing amount left.

For example: A job task ART has $1,000 in unbilled costs, based on 10 time 
entries, 4 vendor purchases, and 1 check. When you add an invoice for the 
job, then enter the task ART, the line item’s billing amount becomes $1,000 
automatically (it is copied from the task’s unbilled total). When the line item 
is saved, the $1,000 billing amount is applied to the task’s costs (oldest costs 
first).  Its costs are marked as billed, one-by-one, until no billing amount 
remains. If you bill less than the task’s unbilled amount, some of your costs 
will remain unbilled or maybe partially billed.

■   Costs with a billing status of on-hold or unbillable don’t get billing 
amounts. You can change the cost’s billing status in the job ticket’s Work in 
Progress window prior to adding the invoice.

You can change the distribution of billing amounts to job costs before post-
ing, letting you change how costs were billed by an invoice.

To use the Billing Worksheet

1  From the Accounts Receivable window, find an invoice.

2  Click on the Worksheet button, or choose Edit > Billing Worksheet.

The costs that were billed by this invoice are listed in order by date.  Each 
cost shows the date, number, cost amount, gross (i.e., billable) amount, 
hours, and amount billed. You can change the invoice’s cost billing any time 
before posting. Once an invoice is posted, its costs can’t be changed.

3  Make your changes the cost status and billing amounts, then click Save.  

Tabbing past the status field saves your changes to the cost and the next cost 
is selected for editing. There are no restrictions on the billing amount, includ-
ing billing a cost for more than its gross amount. Changing a cost’s billing 
information doesn’t affect the invoice, the client balance, or the General Led-
ger. Instead, the changes you make will appear only on the job’s cost reports 
and on the work in progress summary, which shows unbilled costs for all jobs.  

To see a cost’s billing information

Every job cost remembers when and how it was billed. The cost’s billing 
information is easy to see:



6-57The Billing Worksheet

The cost’s billing status affects 
the job’s unbilled total. The 
job’s unbilled total is the sum 
of its unbilled costs. Only 
costs having the status of un-
billed or partial (for partially-
billed costs) will be included 
in the job task’s unbilled total. 

■   To see when an Accounts Payable invoice was billed:  From the Accounts 
Payable window, find the invoice. Then double-click on any of its line items.  
You’ll see the billing information at the bottom of the window. Since each 
cost on an A/P invoice could be billed at different times, they may have dif-
ferent billing dates and invoice numbers.

■   To see when a time entry was billed:  From the Time Sheets window, find 
the time sheet. 
Then double-click 
on any of its en-
tries. You’ll see the 
time entry’s billing 
information at the 
bottom of the 
window.

■   To see when a 
check was billed:  
From the Check-
book window, 
find a 
check, then 
double-click on 
any of the 
line items. You’ll 
see the billing 
information at the 
bottom of the 
window.  Since 
each cost on a 
check 
could be billed at 
different times, 
they may have different billing dates and 
invoice numbers. Checks for payments to 
vendor accounts won’t have billing infor-
mation, since they aren’t job costs.

■   To see when an expense was billed: 
From the Expenses window, find the 
expense (by number or date, for example). 
You’ll see the expense’s billing information 
at the bottom of the window.

To see your job’s unbilled costs

Costs and their billing information can be reviewed by task or for the entire 
job.

■   To see costs for one task:  From the Job Tickets window, click once on a 

job task. Then choose View Task Costs from the pop-up view>point menu. 
The date when the cost was billed appears on the right side of the report.

■   To see costs for one job:  From the Job Ticket window, choose File > Print 
Job Reports. Click on the Job Accounting reports heading, then click on Job 
Costs reports. The billing status for each job cost appears on the right side of 
the report.

■   To see costs 
and billing 
information for 
all jobs:  Choose 
Snapshots > Work 
in Progress. From 
the Unbilled Cost 
reports, select 
Unbilled Costs by 
Job, then enter a 
range of job status 
codes.  Costs 
will be shown for 
all jobs within 
the status range 
selected.
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Applying Advances

Applying Advances

When a job is billed in advance, its billing is saved on the job ticket like a 
deposit. Advance billings (see page 38), which are usually added to pre-bill 
for printing, postage, or creative, don’t affect the job’s total billings. Instead, 
advances only appear on prepayments on the job’s Snapshot window. Ad-
vances have no affect on the income statement of job profit and loss. 

When the job is finally billed, either with a job billing, a multi-job billing, 
or a progress/final billing, its unbilled 
costs are billed in full. Once the invoice 
is saved, the job’s advance billing can be 
applied to the invoice like a payment. The 
Apply Advance Billings window makes it 
easy (see illustration).

■  A job’s advance billing can only be 
applied to its own invoices. It can’t be 
applied to a different client or a different 
job.

When the invoice is posted, the invoice’s 
total—not including the advance pay-
ment you applied—debits your Accounts 
Receivable 
G/L account. The advance payment is 
posted as separate journal 
entries, but with the same reference 
number.  (If you look up the transaction 
in the General Ledger, you’ll see both 
the invoice’s charges and the advance 
payment.) The advance payment credits 
A/R and debits your advance billings 
liability account.

To apply an advance billing to 
an invoice

1  First, add the invoice for the job with the advance billing.

Advance billings can only be applied to invoices added for the same job 
number. However, you can apply a job’s advance billings to any kind of job 
billing (i.e., job billing, progress/final billing and estimate billing).  Advances 
can only be applied to unposted invoices, so don’t post it yet.

2  Once the invoice is saved, choose Edit > Edit > Apply Advance Billings.

The Apply Advance Billing window opens, displaying the invoice’s total 
charges and the job’s advance billing balance. The invoice’s total charges 
includes all of its billing amounts plus sales tax. This is the total to which the 
job’s advance billing is applied.  

3  Enter the amount of the advance billing that should be applied to this 
invoice.

Typically you’d apply the entire advance billing to this invoice. However, you 
can apply any portion of the job’s advance billing now, then save the bal-
ance for future invoices. In any case, the payment applied can’t exceed the 
invoice’s total.

Advance billings are applied to unposted 
job billings, where they appear as pay-
ments. The client sees the invoice’s total, 
including sales tax, but the balance due is 
less the advance payment you’ve made. 
You can apply all or some of the job’s ad-
vance billings to an invoice. If you apply 
the same amount as the invoice’s total, 
then the invoice’s balance will be zero.

■  Press Tab and you’ll see the invoice’s 
new balance due. 

4  Enter the payment’s memo. 

The payment memo appears at the bot-
tom of the printed invoice, next to the 
advance payment amount. You can use 
this memo to describe what you’ve ap-
plied as payment, or why it was applied 
at all. Each invoice has its own advance 

payment memo.

5  Enter the payment’s debit G/L account, then click Save.

The payment’s dGL is debited when the invoice is posted. During posting a 
separate set of debit and credit entries are posted for the amount of the pay-
ment—just as if you’d added the payment yourself in Client Payments. The 
amount of the payment credits Accounts Receivable, since the client owes 
less money, then debits the “deposits/advances” liability account (which 
should have been set up before the advance was billed, as well as entered in 
the Preferences as a default G/L account). 

Once the payment is applied, you’ll see it and the payment’s memo at the 
bottom of the Accounts Receivable window. The advance payment amount 
can be changed any time before the invoice is posted.

Clients see the advance’s 
memo. The memo field ap-
pears on the printed invoice 
to explain why and how the 
job’s advance billing was 
applied. 
It’s completely customizable. 
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Applying Retainers

Retainers are applied to unposted invoices, where they appear as payments.  
The client sees the invoice’s total, including sales tax, but the balance due is 
reduced by the retainer’s payment. You can apply all or some of the client’s 
retainer balance to an invoice. If you apply the same amount as the invoice’s 
total, then the invoice’s balance will be zero.

When the invoice is posted, the invoice’s total—not including the retainer—
debits your accounts receivable G/L account. The retainer is posted as 
separate journal entries, but with the 
same reference number. (If you look 
up the transaction in the General 
Ledger, you’ll see both the invoice’s 
charges and the retainer payment.) 
The retainer payment credits A/R and 
debits your client deposit/retainers 
account.

■  Unlike advances, retainers can be 
applied to any invoice added for the 
client. This means any job billing, 
progress/final billing, multi-job bill-
ing, media billing, or miscellaneous 
billing can be paid off by applying the 
client’s retainer.

To apply a retainer

1  Find a client’s unposted invoice.

2  Choose Edit > Edit > Apply Re-
tainer.

The Apply Retainer window opens, 
displaying the client’s current retainer 
balance and the invoice’s total charges, 
including sales tax. Any part of the 
client’s retainer balance can be 
applied to the invoice’s total.  

3  Enter the payment amount that should be applied from the retainer bal-
ance to this invoice.

You can apply any amount of the retainer to this invoice, but the retainer pay-
ment can’t exceed the invoice’s total. As you enter the payment amount and 
press Tab, you’ll see the invoice’s new recalculated balance due.  

4  Enter the payment’s memo.

The memo appears at the bottom of the printed invoice, next to the retainer 
payment amount. You can use this memo to describe what you’ve applied 
as payment, or why it was applied at all.  Each invoice has its own retainer 

payment memo.

5  Enter the payment’s debit G/L account, then click Save.

The payment’s dGL is debited when the invoice is posted. During posting 
a separate set of debit and credit entries are posted for the amount of the 
payment—just as if you’d added the payment yourself in Client Payments. 

The amount of the payment credits 
Accounts Receivable, since the 
client owes less money, then debits 
the “deposits/advances” liability 
account (which should have been set 
up before the advance was billed, as 
well as entered in the Preferences as 
a default G/L account). 

The retainer’s memo is cus-
tomizable. The memo explains 
why the retainer amount was 
applied as a payment to an 
invoice. It appears on the 
printed invoice, so clients will 
see it
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Printing Invoices

Client invoices can be printed any time after they are posted. Invoices can 
be printed individually, or in batches for a range of invoice numbers. A batch 
of invoices can also be printed for the same client and a range of invoice 
dates; this option lets you print the month’s invoices for one client quickly 
and easily.

The printed invoice shows the line items, billing amounts, descriptions, and 
notes you’ve entered into the 
invoices. Each invoice can 
have its own set of options 
and settings (e.g., display 
options, group and sort, show 
or hide totals, etc.) that affect 
the look of the billing. So 
printing a large number of 
invoices at the same time 
may show a wide variety of 
invoice styles.  

Invoices are designed to 
print on your letterhead.  
The invoice margins are 
customizable, and can be set 
by choosing Invoice Options 
from the Preferences pop-up 
menu. None of the invoice’s 
options can be changed at 
the time invoices are printed. 
To change these options you must make your changes first, then print the 
invoice. The optional agency billing address is printed from Agency Informa-
tion, where it can be changed.

An invoice can be printed then reprinted any number of times.  As an option, 
a job cost report can be printed showing costs billed on these invoices. This 
invoice detail report can be used to back up the billing amounts on invoices, 
if you bill strictly based on costs. If you bill for more than your costs, don’t 
print this report—your client will wonder why you’re overbilling them.

■   Unposted invoices will print if they are part of the selection, but will be 
printed as “billing previews” until they are posted.

To print client invoices

1  Click on the Print Invoices button, or choose File > Print Invoices.

The Print Invoices window lets you select a batch of invoices selected by in-
voice number (e.g., 6006 - 6015), one particular client, and a range of invoice 
dates. The currently display invoice’s number is entered by default, but can 
be changed.

2  Enter a range of invoice numbers and an optional client number.

Any invoice numbered within the range of numbers you enter will be printed 
(or reprinted, in some cases). Enter a client number to print only invoices 
added for one client; the option is useful when a client asks for a reprint of 
the month’s billings.

3  Enter an optional range of 
invoice dates and options.

The currently displayed 
invoice’s date is entered by 
default. Use this option only 
when you need to print a 
set of invoices added on the 
same day or within the same 
time period. 

Use the print invoice detail 
report option to include a 
copy of the job cost report 
with each invoice. Since job 
costs and billing amounts 
are linked, your clients can 
easily see the costs billed 
specifically on an invoice. 
The Invoice Detail Report 
shows gross amounts only, 

so clients won’t actually see what the agency paid for the job’s costs.

Since each invoice can contain up to five distribution names, up to five 
copies of an invoice can be printed automatically. Since laser printers don’t 
handle multipart forms, Clients & Profits prints the distribution name (e.g., 
Acct Exec, Client, Job Jacket, etc.) at the bottom of each invoice. The print 
distribution copies option should be unchecked when printing invoices on 
multipart forms to high-speed dot-matrix printers.

4  Click Print.

■   Since an invoice can be reprinted many times, be careful not to mail out 
duplicate copies of the same invoice just because it printed again.  

■  If you have Adobe Acrobat, invoices can be printed as PDF files and at-
tached to e-mails sent directly to client contacts from Clients & Profits. To 
save or e-mail an invoice as a PDF file, choose PDF from the print to pop-up 
menu.
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The printed invoice

Invoice

Corporate Communications
7405 Von Karmen Avenue
Los Angeles  CA  90012

Don Gibbs Number 11027
Audience Technologies Inc. Date 01/01/07
200 Long Canyon Job Number ATT-150
Palm Springs  CA PO# --
93029 Charge# --

Job Name: Reseller Channel Web Site
Agency Exec. Tammy Burns
Description: Monthly web site managment - Reseller Channel web site

Description Hours Billed Amount

Creative Concepting 8.00 $800.00
Copywriting 5.00 $500.00 *
Creative Subtotal: 13.00 $1,300.00

Photography 5.00 $750.00 *
Production Subtotal: 5.00 $750.00

Computer Graphics/Programming 15.00 $1,500.00 *
Fulfillment Subtotal: 15.00 $1,500.00

Project Management 2.50 $225.00 *
Account Management Subtotal: 2.50 $225.00

SUB-TOTAL: 35.50 $3,775.00

*7.7500% State Sales Tax: $230.56

TOTAL: 35.50 $4,005.56

PAYMENT TERMS: Net 15

Thank you for your business and prompt payment!
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Printing A/R Reports

Accounts receivable reports summarize invoices, showing what you’ve billed 
to clients, jobs, and G/L accounts. A/R reports can be used for reporting 
sales, tracking billings by client, and auditing your accounting. There are 
several different reports that show your billings from various perspectives; all 
reports, however, are based on posted invoices.  

Invoices can be summarized for any period of time (choosing either invoice 
date or date posted), for one period or all periods, and for one client or all 
clients.  These options let 
you find the billings for a 
specific purpose, such as 
the quarter’s billings for 
client ABC.  

A/R reports show only 
posted invoices; unposted 
invoices appear only on 
proof lists.  

Tips for printing A/R 
reports

■   Invoices are selected 
primarily by invoice date 
or date posted.  This option 
lets you show only invoices 
added in July, for example, 
instead of the entire year.  
By entering a range of 
dates, you can select all in-
voices added today, last week, or all month—whatever time period you need.  
There’s no limit to which range of dates you can use.

■  Reports can be printed one at a time by clicking on a report name.  The 
print window remains open after print the report.  This allows you to run 
another report with the same criteria, or edit the selections and rerun the 
same report.  Reports can be printed then reprinted with different selections, 
as often as needed.

■   You can print A/R reports to the window (for a quick on-screen preview), 
the printer (for a hard copy), to export (to create a file that can be opened and 
edited in a spreadsheet program), or to clipboard (so it can be copy pasted 
into a spreadsheet program like Excel).

■   To show the invoice description, click on the Show Description option.  
This option makes your billing reports longer, but more descriptive.

To print A/R reports

1  Click the Print Reports button, or choose File > Print A/R Reports.

2  Select invoice date or date posted from the From pop-up menu, then enter 
a range of dates.
  
3  Select an accounting period, or choose All Periods to see invoices by date 
only.

4  Enter a client number, or leave the selection as ALL.

To see invoices for one 
accounting period only, 
regardless of date, choose 
a period from the pop-up 
menu then enter a very 
large range of dates (e.g., 
1/1/02 - 12/31/02).

5  Select the report you 
wish to print.

6  Click Print.

To print another report 
repeat steps 2-6.
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Billing and A/R Reports

The A/R List - Invoices by Date provides a concise checklist of all invoices added 
for a time period, but does not show the line item detail.

The A/R List - Invoices by Client shows all invoices added for a time period and 
subtotals by client number.

The A/R List - Invoices by Billing Type shows all invoices added for a time period 
and subtotals by billing type.  It prints one page per billing type.

The A/R List - Invoices by AE shows all invoices added for a time period for an AE 
and subtotals them by client.  It prints one page per AE.

The A/R List - Invoices by Division shows all invoices added for a time period for a 
division and subtotals them by client.  It prints one page per division.

The A/R Journal shows invoices along with line item and G/L details.  Use the A/R 
Journal to get a detailed listing of billings for a time period.

The A/R Summary - Billings by cGL lists all invoices added for a time period and 
subtotals by credit account.  It is a helpful auditing report since it corresponds to 
the G/L audit trail for income accounts.

The Group Billings report shows billing amounts subtotaled by task groups.  
Choose to show line-by-line detail (i.e. individual invoices) or task group totals 
only.

The Client Billing Summary is a cover sheet for a batch of printed invoices. It 
can be attached to a large batch of client invoices (which are printed together) to 
make the billing amounts clearer to the client’s accounting department.

The Sales Tax report is useful when preparing sales tax returns.

The Billing Analysis by AE lists invoices by added for each account executive, 
which subtotals by client.  Together with the Billing Recap, these reports can be 
used to compare billings for each account exec or account team.

The Billing Recap by AE report show each AE’s billings as a percentage of total 
billings. 
Account execs and account teams are ranked by total billings. 

The Billing Analysis by Project lists invoices added for each project, subtotaled by 
client.

The Billing Analysis by Group lists invoices added for each task group, subtotaled 
by client. 

A/R List - Invoices by Date

A/R List - Invoice by Client

A/R List - Invoice by Billing Type

A/R List - Invoice by AE

A/R List - Invoice by Division

A/R Journal

A/R Summary - Billings by cGL

Group Billings

Client Billing Summary (Cover Sheets)

Sales Tax

Billing Analysis - by AE

Billing Recap - by AE

Billing Analysis - by Project

Billing Analysis - by Group

Lists

Journals

Summaries

Analysis
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Client Payments

Entries that affect accounts receivable are entered into Client Payments—in-
cluding payments from clients, adjustments, and write-offs. Entries added 
into Client Payments affect client balances, unpaid client invoices, and the 
general ledger at the same time. Client Payments is where you’ll account for 
most of the shop’s incoming cash.

Client payments are typically entered each day as you receive checks from 
clients. Payments are added using the open-item method, which means you’ll 
apply each payment to specific unpaid invoices. Here’s how it works: The 
client’s check is added, then saved. The client’s unpaid invoices are listed by 
date, oldest first. The check’s amount is applied to invoices automatically, 
until the payment is fully applied. For flexibility, you can adjust how a pay-
ment is applied to invoices.  

Client payments must be balanced, which means the payments to invoices 
must equal the check’s amount. If not, the check can’t be saved. Early-pay-
ment discounts can be applied to unpaid invoices, which post to a special 
discount account in the general ledger. 

Client payments aren’t posted automatically. A new client payment can be 
saved, then edited or deleted, any time before it is posted. Posting makes 
the client payment permanent. Reports can be printed from Client Payments 
showing payments made by clients for any range of dates and an accounting 
period. These reports can be compared to audit trails and journals from the 
G/L for easy auditing.

■ Only entries added into Client Payments affect client balances and unpaid 
A/R invoices. If you post entries into the general ledger to update your A/R 
or cash balances, these entries will not affect client invoices.

■  Other kinds of cash deposits, such as interest income, media commissions 
paid, and tax refunds, can be added in Client Payments. These entries aren’t 
added for clients, so they don’t affect accounts receivable or client balances. 
Instead, journal entries are posted into the general ledger only. 

■ Client payments can be grouped together in batches. The batch can be 
shown as a single-line item on the Bank Reconciliation. 

■  A payment sent from a large corporation, that pays invoices from several 
different divisions, can be entered as one payment and split among the divi-
sions (which are set up as separate clients).  

Client payments are seamlessly 
integrated with the general ledger.  
Whenever client payments are 
posted, debit and credit journal 
entries are created automatically.  
Every client payment makes a 
debit (usually cash) and one or 
more credits (usually accounts 
receivable).  Default debit and 
credit accounts are entered for you 
automatically.  

■  The debit account is your primary 
cash account, and is copied from 
your G/L account preferences.  
Client payments increase your 
cash balance.  You can change the 
payment’s debit account to deposit 
the funds into an alternate account, 
such as a money-market account.

■  The credit account is usually 
your accounts receivable account, 
and is copied from the client’s 
invoice.  Client payments decrease 
your A/R balance, since the client 
now owes less.  You can change 
the payment’s credit account 
separately, invoice-by-invoice.  
However, the credit account usually 
isn’t changed.

■  Journal entries from client 
payments are posted into the 
Cash Receipts journal.  The entry’s 
reference number is a combination 
of the prefix PMT# and the client’s 
check number.

■  Journal entries aren’t created, 
and the G/L account balances 
aren’t updated, until a client pay-
ment is posted.

How client payments af-
fect the general ledger

Splitting client payments 
between clients

If your shop has large corporations 
for clients, you probably work on 
jobs for different departments 
within the corporation. In most cor-
porations, checks are written from a 
centralized accounting department. 
These checks typically cover all of 
the agency’s billings for some time 
period, which could include dozens 
of different department’s invoices. 
How are these payments handled 
in Clients & Profits? There are two 
options:

Bill all jobs to the accounting 
department: Although each job is 
opened by the department that is 
requesting the work, the invoices 
can be billed to the accounting 
department. When the invoice is 
added, you’ll replace the job’s cli-
ent number with the client number 
for the accounting department 
(which assumes that you set one 
up). The advantage here is that all 
of the corporation’s invoices appear 
together on the aging report and 
on billing reports. The drawback is 
that you can’t easily track down 
unpaid invoices for each depart-
ment (because they weren’t directly 
billed for them).

Split the client payment: With 
this option, all jobs are billed to 
the job’s client—not a central ac-
counting department. But when the 
payment arrives, it is split between 
all of the department’s invoices 
paid on the check. When a client 
payment is added, you’ll mark the 
split option; you’ll be prompted to 
enter the client number and invoice 
number for each payment. Unlike 
regular client payments, split 
payments can’t be automatically al-
located to unpaid invoices (which is 
the only drawback). The advantage 
is that a single check can elegantly 
pay off any client’s unpaid invoices.
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Client Payment Features

Feature How it works, how it’s used

When a client payment is added, it’s payments can be automatically allocated to the client’s 
unpaid invoices, oldest first. This can be a significant time saver for clients with large num-
bers of invoices, since it saves users the tedious step of applying payments one-by-one. The 
auto-allocation is flexible, though, and can be fine-tuned by the user before the payment is 
saved.

A single payment can be split between different client’s unpaid invoices.  This allows, for 
example, a check for a corporation accounting department to pay off invoices from its vari-
ous departments. 

Client payments can be posted into any accounting period, not just the current period. This 
lets you properly account for payments in the proper period, regardless of when they were 
actually added.

When a client payment is added, Clients & Profits can send an automatic e-mail notification 
to an account supervisor, agency prinicipal, CFO, or any other staff member. This convenient 
feature keeps management better informed about incoming cash. This can be especially 
important when slow-paying clients finally pay their bills.

Every client payment can be given a batch number. Batch numbers match the number pre-
printed on most deposit slips. They can be used to track bank deposits with client checks. 
Also, the Bank Reconciliation can reconcile deposits in batches, which can be simpler than 
reconciling hundreds of separate client payments.

There is no limit to the number of invoices that can be paid off by one client payment.

Because Clients & Profits is an integrated accounting system, a client payment automatically 
updates the client’s unpaid job costs (i.e., Accounts Payable invoices). Each vendor invoice 
keeps track of when it was billed, then when the client paid it. The A/P Aging report has a 
special column showing whether or not the client has paid the job’s invoice; if so, then the 
vendor’s invoice is ready to be paid. This feature is essential if you don’t pay your vendors 
until the client pays you.

Client prepayments, deposits, and advances can be added as retainers without actually 
creating an invoice in Accounts Receivable.  Payments added as retainers update the client’s 
retainer balance, then can be applied later to unpaid A/R invoices.

Adjusts to an invoice’s balance can be made on-the-spot while distributing a client pay-
ment. These adjustments, which can account for service charges, late fees, or early-payment 
discounts, update the General Ledger when the payment is posted.

Auto-allocated payments

Splits

Accounting periods

Automatic C&P e-mail

Deposit batches

Unlimited distribution

Client paid A/P invoices

Retainers, advances

Discounts, adjustments

The diary records the when, where, and who was involved for major events or meetings.  
Because the diary is easily accessed, details of conversations and events are preserved.  The 
record  can also be e-mailed for streamlined communication.

Client Diary

Bank deposits When a check is received that doesn’t pay off a client’s invoice balance due, a bank deposit 
can be used.  Deposits don’t affect accounts receivable and do not affect the client agings.
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Client Payments window

1  The arrow toolbar buttons 
can be used to scroll through 
the previous and next client 
payments.

2  Client payments can be eas-
ily added, edited, redistributed, 
and deleted using these four 
toolbar buttons.  To add a new 
client payment, click on the 
add button.  (To add a bank 
deposit, choose Edit > Add 
Bank Deposit.)  To edit a client 
payment, click on the edit 
button.  If the client payment 
is unposted, you can change 

the payment’s check number, 
date, check date, accounting 
period, dGL, description, bank 
ID number, and batch number.  
If posted, only the payment’s 
description can be edited.  You 
can’t change the payment’s 
client number because it is 
distributed to specific client 
invoices.  The amount can’t 
be changed either to prevent 
an unbalanced entry.  If these 
fields need to be changed, 
you’ll need to delete the pay-
ment using the delete button 
and re-add it.  Once a payment 
has been posted it can’t be de-

leted, you will need to unpost it 
first.  When you need to change 
the  payment’s distribution, 
click on the redistribute button.  
Redistributing a payment erases 
its existing line items and al-
lows you to apply the payment’s 
total amount to a new set of 
client invoices.  

3  To print client payment re-
ports, click on the print reports 
button.

4  Enter a client payment 
number here to find a payment.  
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Entries added into Client Payments affect client balances, unpaid client invoices, and 
the general ledger at the same time.  
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Batch numbers simplify bank deposits.  Deposit slips can be printed from Clients & 
Profits totaling checks by batch number.  The batch number is entered from the pre-
printed deposit slip and any user-defined number or date.

   The Client Payments window

Or use the find more link to find 
one or more payments by check 
number, date, client, check 
date, deposit batch, amount, or 
sequence.  
5  Use the history pop-up menu 
to jump to a previously viewed 
client payment.

6  Click on the client diary link 
to view, add or delete client 
diary entries.

7  Every payment (except split 
payments) gets a client number. 
The client number links the 
payment to the client’s invoices.

8  This is the date the client 
payment was added.

9 The description explains 
something about a payment 
(e.g., payment on account).  
It is copied to the payment’s 
journal entries, so appears on 
G/L reports.

10  The check date is the date 
on which the client’s check was 

written and the G/L accounting 
period is the period the client 
payment was posted.  The dGL 
is the client payment’s debit 
G/L account, usually the cash 
account.  The dGL is copied 
automatically from your G/L 
preferences.

11  Type identifies a payment 
record as a client payment, a 
write-off, a bank deposit, or 
some other user-defined type.

12  This is the date the client 
payment was posted into the 
General Ledger.

13  This is the total amount 
the client paid, including any 
discounts or adjustments.  This 
amount is applied to the client’s 
unpaid invoices.

14  The payment’s batch 
number is used to group the 
day’s checks together. It can be 
the preprinted number from the 
bank’s deposit slip, or a user-
defined code (such as the date).

15  Added by are the initials of 
the person who added the client 
payment.

16  This is the number printed 
on the client’s check.  It is 
used for finding checks later, 
so it should be unique.  It is 
required.

17  Client payments are distrib-
uted to one or many unpaid in-
voices.  Every invoice payment 
can include a discount amount 
and a discount G/L account.  
Every client payment must be 
applied to at least one invoice.  
Double-clicking on a line item 
shows its details.  
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Client payments should be added when you receive the client’s check.  You’ll track 
your cash better, since deposits will be accounted for faster.  Client payments are 
applied to unpaid invoices.  When the payment is posted, the invoices will appear as 
paid.

The Add Client Payment Window

The Add Client Payment Window

1  The client number links 
the payment with the client’s 
unpaid invoices. 

2  Tabbing past the client looks 
up its up-to-the-minute balance 
due. 

3  To split the payment between 
several clients use the split 
payment option. A single check 
from a large corporation can 
be split and distributed to out-
standing invoices from several 
divisions or departments.   

4  A client payment can be 

added as either a payment 
on account, a write-off, 
retainer/deposits/advances, or a 
user-defined type of payment. 
Payments, write-offs, and user-
defined payment types are ap-
plied to unpaid invoices.  Only 
retainer/deposits/advances  are 
handled differently.  They are 
added to the client’s retainer 
balance and you’ll need to enter 
a cGL account (e.g., client 
retainers or deposits) for them. 

5 The auto-allocate option au-
tomatically applies a payment 
amount to the client’s unpaid 

invoices.  If you don’t select 
this option, you’ll have to apply 
payments to invoices manually.

6  The payment amount is 
entered from the client’s check. 
It will be applied to the client’s 
unpaid invoices.  

7  The description describes 
this payment.  It defaults to 
“payment on account”, but can 
be changed.  The payment’s 
description is copied to journal 
entries and appears on client 
payment reports.
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8  Check date is the date from 
the client’s check.  It is the 
date the client wrote the check.  

9  A client payment can be 
posted into any unlocked ac-
counting period.

10  This is the check number 
from the client’s check.  You 
can find client payments by 
check number.  Payment date is 
the date on which the payment 
was added.  Client payment 
reports can be printed for this 
payment date.

11  The bank ID number is the 
bank’s identification number 
that appears on the check and 
prints out on deposit tickets.

12  The deposit batch is a 

The Add Client Payment Window

The auto-allocate option is a time saver.  If selected, clicking the Save button will 
automatically apply the payment’s total amount to the client’s oldest unpaid invoices 
for you.  If necessary, the actual amounts applied to invoices can be changed.

user-defined field that groups 
the payments with the same 
batch number together.  Enter 
the number from the preprinted 
deposit slips, if available; oth-
erwise, enter the deposit date. 
Reports can be printed showing 
payments by deposit date, 
which is useful for reconciling 
your cash account. Deposits 
can also be consolidated on the 
Bank Reconciliation window to 
show as one batch total.

13 The client’s check amount 
debits your cash account in 
the General Ledger, and is ap-
plied to unpaid invoices. The 
payment’s debit account, which 
is usually the primary check-
ing account, is copied from 
the G/L preferences but can be 
changed.
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1  The client payment’s client, 
description, and amount appear 
here for reference.

2  The client’s unpaid invoices 
are listed here.  Clicking on an 
invoice in this list selects it for 
payment, then prompts you to 
enter a payment amount. 

3  The client’s unpaid invoices 
are sorted by invoice number, 
but can be sorted by clicking on 
any column heading.

4  The invoice’s balance 

includes any prior payments.  
Only posted payments affect 
the invoice’s balance.

5  Enter any early-payment 
discount, finance charge, or 
any other kind of adjustment 
to the invoice’s balance here.  
Adjustment amounts affect the 
invoice, client, and General 
Ledger; jobs are not affected by 
adjustments. 

6  The discount G/L number is 
a debit account.

7  Enter the payment amount 
here.  When the payment is 
posted, both the adjustment 
amount and the payment 
amount updates the invoice.

8  The payment’s cGL is copied 
from the invoice’s dGL (i.e., 
A/R)

9  The unallocated payment 
is the amount of the payment 
that has yet to be applied to the 
client’s invoices. The client pay-
ment can’t be saved until this 
amount is zero—which means 
the payment is fully applied to 
receivables.

The Distribute Payments window

Distribute Payments

Once a payment is saved, the Distribute Payment window opens, listing the client’s 
unpaid receivables. Only posted invoices appear on the payment distribution window.
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Split Client Payments

Split client payments are added like standard client payments, but have a few differences:  the auto-allocate 
option isn’t applicable, and you’ll be prompted to enter a combination of client and invoice numbers for every 
invoice that will be paid by a split payment.  Since split payments can’t be automatically allocated, you’ll 
need to have a list of invoices (including client numbers) that will be paid with the split client payment.

1  Enter in the client number.  

2  Enter the client’s invoice 
number.  If you don’t know the 
exact invoice number, leave 
the field blank then press Tab.  
The Client Invoices lookup 
list opens, listing the client’s 
unpaid invoices.  Double-click-
ing on an invoice copies it to 
the Distribute Client Payments 
window.  

3  Tabbing past the invoice 
number displays its balance 
due and the credit G/L number 

(i.e.,  A/R).
4  Enter the discount amount 
and discount G/L account, 
if applicable.  The discount 
amount will affect the invoice, 
client, and General Ledger; jobs 
are not affected by adjust-
ments.

5  Enter the invoice payment 
amount.  This is the amount of 
the client payment that will be 
applied to this client invoice.  

6  The credit G/L account 
already appears, but it can be 

changed.

7  The unallocated payment 
box shows you how much of 
the payment that has yet to 
be applied to client invoices.  
The split client payment can’t 
be saved until this amount 
is zero—which means the 
payment is fully applied to 
receivables.

Split client payments makes it easy to pay invoices from several different divisions of 
a large corporation.
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1  The date added is the date 
on which the bank deposit was 
added.  

2  The bank deposit amount 
debits your cash account in the 
General Ledger. The payment’s 
debit account, which is usually 
the primary checking account, 
is copied from the G/L prefer-
ences but can be changed.

3  This amount is entered from 
the bank deposit’s check.     

4  The description describes 

this bank deposit. The bank 
deposit’s description is copied 
to journal entries.

5 Check date is the date from 
the bank deposit’s check.  It is 
the date the check was written. 

6  This is the check number 
from the bank deposit’s check.  
You can find client payments by 
check number. 

7  A bank deposit can be 
posted into any unlocked ac-
counting period.

8  The Bank ID number is the 
bank’s identification number 
that appears on the check and 
prints on deposit tickets.

9  The deposit batch is a user-
defined field that groups the 
payments and/or bank deposits 
with the same batch number to-
gether.  Enter the number from 
the preprinted deposit slips, if 
available; otherwise, enter the 
deposit date. Reports can be 
printed showing payments by 
deposit date, which is useful for 
reconciling your cash account. 

Bank Deposits  

Bank Deposits

Since deposits aren’t added for a client, they do not affect accounts receivable or client 
balances.  When posted, they update the General Ledger and Bank Reconciliation only.
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Deposits can also be consoli-
dated on the Bank Reconcili-
ation window to show as one 
batch total.

10  The bank deposit can be 
distributed to one or more cGL 
accounts.  

11  This is the total amount 
of the bank deposit’s distribu-
tion amounts. This total must 
equal the amount shown on the 
deposit slip. 

Bank deposits are a special payment type used when your agency receives a check that doesn’t pay 
off a client’s invoice.  Bank deposits can be used to add checks for such things as cash deposits, 
interest income, media commissions paid, or tax refunds.  

Bank Deposits
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Printing Client Payment Reports

Printing Client Payment Reports

Client payment reports summarize payments, write-offs, and other transac-
tions that affect client account balances.  These reports show what has been 
paid by clients, including invoice numbers and G/L accounts.

There are several different reports that show your client payments from vari-
ous perspectives; all reports, however, are based on posted payments.  
Payments can be summarized for any period of time (choosing either pay-
ment date or date posted), for one period or all periods, and for one client or 
all clients.  These options 
let you find the clients for a 
specific purpose, such as the 
year’s payments by client 
ABC.  

Client payment reports 
show only posted payments; 
unposted payments appear 
only on proof lists.  

Tips for printing cli-
ent payment reports

■  Payments are selected 
primarily by payment date or 
date posted.  These options 
let you show only payments 
added in July, for example, 
instead of the entire year.  
By entering a range of dates, 
you can select all payments 
added today, last week, or 
all month—whatever time period you need.  There’s no limit to which range 
of dates you can use.

■  You can print client payment reports to the window (for a quick on-screen 
preview), the printer (for a hard copy), to export (to create a file that can be 
opened and edited in a spreadsheet program), or to clipboard (so it can be 
copy pasted into a spreadsheet program like Excel).

■  To show the payment’s description, click on the Show Description option.  
This option makes your payment reports longer, but more descriptive.

To print client payment reports

1  Click the  (i.e., Print Reports) button, or choose File > Print Client 
Payment Reports.

2  Select date added or date posted from the From pop-up menu, then enter 
a range of dates.
  
3  Select an accounting period, or choose All Periods to see invoices by date 
only.

4  Enter a client number, or leave the selection as ALL.

To see invoices for one accounting period only, regardless of date, choose 
a period from the pop-up menu then enter a very large range of dates (e.g., 
1/1/02 - 12/31/02). 

■  Client payment reports can also be printed by deposit batch numbers by 
choosing Deposit Batch from the ...and pop-up menu, then entering the batch 

number.

5  Select the report you 
wish to print.

6  Click Print.

To print another report 
repeat steps 2-6.

To print deposit 
tickets

Deposit tickets can be 
printed for any batch of 
client payments, deposits, 
or retainers that have been 
posted.  Since deposit tick-
ets can be printed directly 
from Clients & Profits (using 
standard preprinted forms), 
it saves you the time and 
effort of filling out your 

bank deposit tickets by hand.       

Clients & Profits uses a standard laser-compatible deposit ticket form from 
Deluxe Business Forms.  Any deposit ticket form can be used, but remember 
to test print a deposit ticket before ordering from another vendor.    

1  Choose File > Print Deposit Tickets.

2  Enter the batch number, or leave the selection as ALL.

3  Enter a range of posted dates.

4  Click Print.
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Client Payment Reports

Client Payment List

Client Payment Journal

Client Payment Summary

Deposit Summary

The Client Payment List provides a concise checklist of all payments added for 
a time period, but does not show line item detail.  The report can be run for 
one client or one deposit batch.

 Client Payment Journal to get a detail listing of payments for a time period.

The Client Payment Summary lists payments by credit account. 

The Deposit Slip report lists the client payments subtotaled by the deposit 
batch number and shows individual check numbers, check dates, and amounts. 

Lists

Journals

Miscellaneous

Clients & Profits uses a standard laser-compat-
ible deposit ticket form from Deluxe Business 
Forms.  Any deposit ticket form can be used, 
but remember to test print a deposit ticket 
before ordering from another vendor.    
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Collection Manager

Collection Manager

The Collection Manager is a terrific tool for improving how you get paid. It’s like a Daily Job Status report for your 
unpaid invoices, listing everything owed to you by your clients. Receivables are color-coded by age, highlighting the 
problem invoices so that they can get the top priority by the billing department.

When the Collection Manager 
window is opened, it lists every 
posted, unpaid invoice from 
Accounts Receivable. Every 
invoice for every account 
executive or account team is 
included.

Only C&P X users with access 
to the Collection Manager can 
open this window.

Invoices are grouped together 
by client then sorted by invoice 
number. For each invoice you’ll 
see its billing date, due date, 

total billed, balance due, and 
payment status. Clicking on 
an invoice displays its billing, 
payment, and collection status 
in the tab area at the bottom of 
the window.

1  Clicking the change status 
button will update the payment 
status on one or more selected 
invoices. The payment statuses 
documents what has last hap-
pened to get the bill paid. They 
are preset in Clients & Profits 
X (they can’t be customized) 
and are arranged in roughly the 

order they should be performed. 
They include:  Invoice sent, 
courtesy call, resent invoice 
+ reminder, sent statement, 
follow-up call, account on 
credit hold, sent demand letter, 
last chance call, sent FINAL 
NOTICE, payment doubtful, 
sent to collections, write-off, 
and disputed billing.

2  Click the print button to get 
a hard-copy report of the Col-
lection Manager window, which 
subtotals all unpaid receivables 
by client.

Clicking on an unpaid invoice displays helpful information, including payment status 
and past collection calls. It also lets you plan the next follow-up action.  

t

r

e

wq



6-77Collection Manager

Use the collection status to track what you’ve done to get an invoice paid, similar to the 
billing work flow for unbilled jobs. The different statuses methodically walk through the 
collection process until the invoice is paid—or written off as uncollectable.  

3  To focus on unpaid invoices 
for one client, choose the client 
from the client pop-up menu.

4  The payment status classifies 
each invoice by the last collec-
tion follow-up. Newly posted 
A/R invoices automatically 
get the invoice sent payment 
status. When an invoice is 
paid, it stops appearing on 
the Collection Manager. Color 
coding identifies each invoice’s 
age. Invoices less than 60 days 
past due appear in green, while 
invoices less than 90 days old 
appear in yellow. Invoices past 
due 90 days or more appear 
in red. In addition, an optional 
payment status note can be 
included to better explain the 
invoice’s payment status.

5  Clicking on an invoice in the 
Collection Manager displays 

billing and payment details. 
Clicking on a tab displays the 
invoice description, payment 
status, past collection actions, 
and the next collection action.

About This Invoice shows the 
invoice’s billing type (e.g., 
progress/final billing, estimate 
billing, advance billing, etc.), 
the client contact to whom the 
invoice was billed, the invoice’s 
job number, the invoice descrip-
tion, who added the invoice, 
and the invoice’s days until due 
(or past due).  

Payment Status displays the 
invoice’s current status, which 
you can change by selecting a 
status from the pop-up menu. 
In addition, you can enter an 
optional note to document 
more about the invoice’s pay-
ment status. To change an 

invoice’s collection status, 
enter your changes then click 
on another tab or click on a 
different invoice in the list, 
which will prompt you to save 
the changes.

Collection Actions lists prior 
phone calls, letters, and meet-
ing notes from the client diary 
that were added with an invoice 
number.

Next Action lets you schedule a 
follow-up phone call, letter, or 
e-mail for the selected invoice. 
You can assign an upcoming 
collection action to any staff 
number (for example, the cli-
ent’s account executive) by en-
tering their initials in the “by” 
field. These collection actions 
will appear on the Account-
ing Calendar and in the staff 
member’s personal calendar. 

To change an invoice’s next 
action, add your changes then 
click on another tab or click on 
a different invoice in the list, 
which will prompt you to save 
the changes.  


